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  تعلم لغــة البرمجة 

Microsoft Visual FoxPro 9.0  

  معاذ مباركي:إعداد

E-mai : 

mebarkimouaadh@Gmail.com 

Tel :+(213)0792306382 

  

  

  

  :إهداء

وحدك أنت إليك  
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  :مقدمــة

  :Visual FoxProتاريخ 

إلــى أمد بعدي جدا أي في بدايــة الثمانيات  يرجع تاريخ لغة البرمجة فكس برو

ا تم عمل نسخــة من قاعدة همع إنتشار أجهزة الحاسوب الشغصيــة وتتطور

ونظرا لنجاع هذا البرنامج بدات  Dos، لتعمل تحت نظام  +Dase3البيانات 

العديد من الشركات المنافســة بإنتاج برامج شبيهــه لتنافس تلك اللغــة 

، حيث Quick Silver &FoxBase،Clipperوكان من هذه البرامج و أهمها 

غــة يحتل في ذالك الوقت المرتبــة الأولى، والتي تعتبر لغة برمجة لClipper كان 

،ولقد نشأ exeينتج لنا ملفات بصيغة  Comilerبرمجة لئحتوائها على مترجم 

وإستمر في  Clipper87وبدأ في الإنتشار حتى بالإصدار  1980برنامج كليبر عام 

لينتهي بذالك برنامج  Windowsثم ظهر بعد ذالك  Clipper5التطور حتى 

، وفي CA-Clipper5.2e ,CA-Clipper5.3bكليبر بالإصدرارين الشهيرين 

ثم ظهر +FoxBASEوالتي كانت تتميز بالسرعة إلى FoxBaseالجانب الإخر تطور 

ثم جاء Foxpro 2.6 for Dosواستمر في التطور ختى  Foxproبعد ذالك 

Foxpro for windows  وإستمر حتىVisaul Foxpro3.0 والذي كان

برمجة ثم ظهر بعد ذالك نقلة نوعيــة للتحول به من مجرد قاعدة بيانات إلى لغـة 

Visaul Fox pro ثم ظهر كل من الإصدرات  دون المرور بالإصدار الرابع 

  )من كتاب للأخ محمود فايد مقتبس( 6.7.8.9

ولقد إشترت مايكروسوفت  1980ويعود تاريخ الفكس برو إلى سنــة 

على نظام قاعدة بيانات ولغة برمجة  Foxproحيث يعتوي  1992حقوقــه سنة 

  .معا، وهي يعتبر من أحسن في إدارة قواعد البيانات
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 Visaul Studioمن  Foxproولقد عزلت مايكروسوف 

نقلــة نوعيــة في تاريخ الفكس برو وبمجرد نزولــه سنة  9ويعتبر الإصدار 

إزداد الطلب على الفكس برو، وخاصــة تلك الحادثــة حين قام عدد  2000

والذي يعد  Linux/WINEمن خلال  Visaul Foxproمن المبرمجين بتشغيل  

إنتهاك صريح لسياســة مايكروسوف والتي تشترط ان تعمل البرامج التي يتم 

  .فقط  Windowsتطوريها لغة الفكس برو من خلال منصة 
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  Microsoft Visual FoxPro 9.0كيفيــة تثبيت 

ما علينا سوى  Microsoft Visual FoxPro 9.0من أجل تثبيت 

من خلال موقع الخاص ذه اللغة على موقع  Foxproتحميل لغة البرمجة 

  :من خلال الرابط التالي Microsoftشركــة 

.http://msdn.microsoft.com/vfoxpro  

 على البريد الخاص  أو يمكنك مراسلتي

mebarkimouaadh@Gmail.com : mail-E 

  بعد الإنتهاء من عمليــة التحميل ننتقل الان إلى عملية التثبيت

  كما هو مبين في الصورة التاليــة Setupنقوم بالضغط على 

  

  

 Visual Foxpro Setup:نحصل على النافذة التالية بعنوان 
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 prerequisitesنقوم بإختيار 
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  كم هو موضح في الصورة أعلاه ! Update Nowثم نقوم بإختيار 

  نلاحظ أن البرنامج يقوم بعمليــة التثبيت دون أي خطأ
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، كما هو موضح فــي  Doneبعد الإنتهاء من عمليــة التثبيت نضغط على 

  الصورة التاليــــة
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 Visualبعد الغنتهاء من عمليــة الثبيت نلاحظ ظهور النافذة الأولـى 

FoxPro  
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  Visual FoxProالأن ننتقل إلى عمليـــة تثبيت 
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أي الموافقة البنود الخاصـة   I Accept the agreementنقوم بالنقر على 

  بلغة البرمجة الفكس برو

 product Keyثم نقوم بكتابــة السريال من خلال 

  Serial: W7YCJ-2RRMD-MMHGG-3MB7C-VBMYB :والسريال هو  

 Continueثم نقوم بالضغط على 

 

  نختار مسار التنصيب كما هو موضح في الصورة التاليــة

  

 C:\Program Files\Visual FoxPro9نختار مسار التنصيب 

 218.88MBونلاحظ أن حجم البرنامج بعد عمليــة التنصيب هو 
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  البرنامج يقوم بعمليــة التثبيت دون أي خطأنلاحظ أن 

  

 

  بعد الإنتهاء من عملية التثبيت سوف تظهر لنا النافذة التالية 

  

   Doneنقوم بالنقر على 



 E-mail :mebarkimouaadh@Gmail.com Page 

13 

Microsoft Visual FoxPro 9.0 كتاب تعلم    

Tel :+(213)792306382 رآ�                                                    :إ��اد����ذ   

 

  Microsoft Visual FoxPro 9.0التعرف على 

  Microsoft Visual FoxPro 9.0تشغيل 

التي   Windowsأو إبدأ حسب    Démarrerاو  Starنثوم بالنقر على 

  :ونتبع الخطوات التاليــة تستعملها أنا أستعمل النسخة الفرنسيــة

 Démarrerنقوم بالنقر على زر •

 Tous les Programmesنقختار  •

 Microsoft Visual FoxPro 9.0 ثم نختار •

  :كما هو مبين في الصورة التاليــــــــة

 

 Foxpro 9.0فتظهر لنا الشاشــة الأساسية الخاصة ب  

  :كما هو مبين في الصورة التاليـــــــــــة
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وبطبيعــة الحال لغة البرمجة الفكس برو لا تختلف عن أي لغة برمجة أخرى فهي 

  تحتوي على شريط العنوان، شريط القوائم، شريط الأدوات

  

 :)Command Windows(نافذة الأمر 

فمن خلال نافذة الأمر يمكننا ادخال أوامر لغة البرمجة الفكس برو وتنفيذها مباشرة 

أو التنفيذ  Enterويمكننا تنفيذ الأمر من خلالها وذالك بكتابـة الأمر ثم نضغط على 

  .دفعــة واحدة

وفي حالــة أدخال أمر خطأ سوف تحصل على رسالــة تفيد بذالك كما هو 

  :التاليــــــــــــةموضح في الصورة 
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 والمتوقع حصول على خطأ لان الفكس برو لا يحتوي على على أمر يدعى 

Hello programming By mouaadh mebarki 
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 Hello Worldالرنامج الشهير 

  Microsoft Visual FoxPro 9.0نقوم بالدخول إلى 

  

  ..Newثم نحدد   Fileثم نختار 

  New fileثم نضغط على  programثم نحدد 

  :كما هو مبين في الصورة التاليـــــــة
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  ثم نقوم بكتـــــــــابــه الكود كما هو مبين في الصورة 

  

 الكود هو 

 

 

 

 

 

 

 

SET COLOR To W/N 
CLEAR 
?"Hello World"Font"",35 
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أو من خلال لوحة المفاتيح من  بالضغط على الزر  Runثم نقوم بعمليــة 

 Ctrl+Eخلال 

  ثم نقوم بعمليــة حفظ البرنامج في أي مجلد او ملفد داخل الحاسوب 

  :ونلاحظ البرنامج يعمل بسلاســة ودون أي أخطاء كم هو مبين في الصورة التالية
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  :الألوان التي يتعامل معها الأمر

 SETمن خلال الدرس السابق نكون قد تعرفنا على أمرين مهمين أحدهما هو الأمر 

COLOR TO  والذي استخدم لتحديد الألوان وبأخذ ذالك الأمر لون الكتابــة

  .ثم العلامــة المائلـة والتي يليها بعد ذالك لون الخلفيــة

والذي يفهم من معناه انــه يقوم بمسح الشاشــة  CLEARأما الأمر الثاني 

  وذالك بالألوان المحددة

  الألوان التي يتعامل معها هذا الأمرأما الأن سوف نتعرف على جدول يبين 

Code  Color 

N  Black  
X  Balnk  
B  Blue  

GR  Brown  
BG  Cyan  

G  Green  
I  Inverse  

RB  Magenta  
R  Red  

W  White  
GR+  Yellow  

U  Underlined  
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 ):The Main Menu Bar( الرئيسية القوائم شريط

 الخاص المكتب سطح من الثانية الشاشة خط على الرئيسية القائمة شريط يظهر

FoxPro  .من غيض مثل هو القوائم شريط هذا و كثيرة، نواح في 

 النقر عند المنبثقة القائمة يعرض ، القائمة لوحة ودعا ، القائمة في خيار كل. جليد جبل

 .  فوقه

 أن يمكن المنبثقة أن من الرغم على.  الخيارات قائمة من أكثر أو اثنين على يحتوي

 احدة الإجراءات يقترن أفضل ممارسة وهي ، واحد خيار لها يكون

  . مباشرة القائمة لوحة مع

 وضوحا الأكثر طريقة.  طرق عدة في خياراا و القائمة منصات اختيار يمكنك

 . عليها للنقر الماوس يستخدم

   الملف الأولى، وسادة على الضوء يسلط و القائمة، تنشيط F10 على الضغط

 تلك فتح يمكنك.  واحد مسطر حرف قد القائمة لوحة كل أن لاحظت قد كنت

 الضغط طريق عن مباشرة منبثقة نافذة في القائمة

 سبيل على ملف، القائمة لفتح.  المسطر الحرف مع جنب إلى جنبا) Alt( المفتاح

 مفتوحة، المنبثقة القائمة أي مع.  Alt + F على اضغط ، المثال

 الأعلى مفاتيح.  أخرى منصات إلى للانتقال الأيمن السهم أو اليسارية مفتاح استخدم

 و الحالية لوحة المنبثقة القائمة فتح لأسفل السهم و

  . خياراا خلال من التحرك
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 يتحرك السهم السفلي أو العلوي مفتاح على والضغط مفتوح، المنبثقة أن حين في

 على الضغط. آخر إلى واحد خيار من الضوء تسليط

 القائمة لها ويفتح التالية القائمة لوحة الرئيسية التحركات الأيمن السهم للأو ينتمون

 الحق على الضوء سلط الخيار يتضمن لم ما المنبثقة،

 فتح الأيمن السهم مفتاح على الضغط الحالة هذه وفي حقها، الحدود طول على السهم

 إلى. إضافية خيارات تسرد التي الفرعية القائمة

 يعمل ماوس بنقرة. Enter واضغط عليها الضوء وتسليط القائمة، عنصر اختيار

 المسطر الحرف على اضغط حتى يمكنك. كذلك فقط

 على تضغط لا وكنت المنبثقة، القوائم في أنه لاحظ. واحد لديه كان إذا الخيار، في

 .المسطر الحرف مع بديل مفتاح

 التي الاختصار، مفاتيح وتسمى الرئيسية، خاصة مجموعات لديها القائمة خيارات بعض

 مباشرة الخيار هذا إلى القفز من تمكنك

 على الاختصار مفاتيح هذه FOXPRO يعرض. القائمة منصات عبر المرور دون

 ال. المنبثقة القوائم من الأيمن الجانب طول

 أنه يعني هذا. N+  السيطرة هو المثال، سبيل على جديد، لملف الاختصار مفتاح

 Visual في وجودك أثناء وقت أي Ctrl + N على الضغط يمكنك

FOXPRO جديد ملف لفتح النشطة النظام قائمة مع  

  :المتاحة الاختصار مفاتيح يلخصو الجدول التالي 
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Shortcut Key  Menu Option  Menu  
Ctrl+N  New  File  
Ctrl+O    Open  

Ctrl+S    Save  

Ctrl+P    Print  

Ctrl+Z  Undo  Edit  
Ctrl+R    Redo  

Ctrl+X    Cut  

Ctrl+C   Copy  

Ctrl+V   Paste  

Ctrl+A   Select All  

Ctrl+F   Find  

Ctrl+G   Find Again  

Ctrl+L   Replace  

Ctrl+D Do  Program  
Ctrl+M   Resume  

Ctrl+E   Run current 
Program  

Ctrl+F1 Cycle  Window  
Ctrl+F2   Command 

Window  
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The File Menu Options:  

  

 ملفات إنشاء(  الملفات إلى الوصولب المتعلقة الخيارات على المنبثقة القائمة تويتح

  .ويصف الجدول هذه الخيارات) .  والطباعة ، وإغلاق ، القائمة وفتح ، جديدة

  Description  Menu Option  الوصف

.  جديد الحوار مربع يفتح

 مربع في الخيارات تمكن

 هذا الحوار

 عمل فرص خلق ل لك

 وقواعد المشاريع جديدة

 الجداول و البيانات

 و والاستعلامات

 ، الاتصالات

Opens the New 
dialog box. The 
options in this 
dialog box 
enable 
you to create 
new projects, 
databases, 
tables, queries, 
connections, 
views, remote 

New  
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 عن والآراء النظر وجهات

 والتقارير النماذج و بعد،

 ، البرامج و والملصقات

 والنص ، والطبقات

  . والقوائم الملفات

views, forms, 
reports, labels, 
programs, 
classes, text 
files, and menus.  

 ، فتح الحوار مربع يفتح

 نوع أي يفتح والذي

 تحت المدرجة الملفات

  الجديد

Opens the Open 
dialog box, 
which opens any 
file type listed 
under 
New.  

Open  

 إذا.  النشط الإطار إغلاق

 مفتاح على ضغطت

Shift الملف فتح و 

 هذا ويصبح ، القائمة

 الذي جميع، إغلاق الخيار

 مفتوحة كلها يغلق

  نوافذ

Closes the active 
window. If you 
press Shift and 
open the File 
menu, this 
option becomes 
Close All, which 
closes all open 
windows.  

Close  

 الإطار في الملف يحفظ

.  الحالي اسمها مع النشط

 لاجل

 له ليس الذي الجديد الملف

 يطالب الخيار و ، اسم

 ل المستخدم

  .الملف اسم

Saves the file in 
the active 
window with its 
current name. 
For a 
new file that has 
no name, the 
option prompts 
the user for a 
filename.  

Save  

  Prompts the Save As اسمب المستخدم يطالب
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 حفظ قبل جديد ملف

  . الملف

user for a new 
filename before 
saving the file.  

 أو الحالي النموذج يوفر

 فئة تعريف اختياره ضوابط

 داخل من فقط نشط(

  ) . مصمم النماذج

Saves the 
current form or 
selected controls 
as a class 
definition 
(active only 
from within the 
Form Designer).  

Save As Class  

 التي التغييرات إلغاء

 الحالي الملف على أدخلت

  الحالي التحرير خلال

Cancels changes 
made in the 
current file 
during the 
current editing 
session.  

Revert  

 برنامج ملف ستوردي

Visual FoxPro أو 

 جانب من منسق ملف

 آخر

 أيضا يمكنك. التطبيق

 الخيار هذا استخدام

  .استيراد معالج لتشغيل

Imports a Visual 
FoxPro file or a 
file formatted by 
another 
application. You 
can also use this 
option to start 
the Import 
Wizard. 

Import 

 مرئي ملف تصدر

FoxPro ملف تنسيق في 

  .آخر تطبيق

Exports a Visual 
FoxPro file in 
another 
application's file 
format. 

Export 

 Changes the و الصفحة تخطيط تغيير
page layout and 

Page Setup 
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 printer settings  .للتقارير الطابعة إعدادات
for reports. 

 و نافذة في صفحات يعرض

 عند تظهر سوف أا

  الطباع

Displays pages 
in a window as 
they will appear 
when printed. 

Page Preview 

 الإطار محتويات طباعة

  الحالي

Prints the 
contents of the 
current window, 
a file, or Visual 
FoxPro's 
Clipboard. 

Print 

 البريد إرسال من تمكنك

  .الإلكتروني

Enables you to 
send email. 

Send 

 إلى سريعا وصولا يوفر

 الأربعة من أي فتح إعادة

 فتحل الأخيرة

  .المشاريع

Provides quick 
access to reopen 
any of the last 
four opened 
projects. 

<project files if 
any> 

 Visualخروج من 

FoxPro.  

Exits Visual 
FoxPro. 
Choosing this 
option is the 
same as typing 
QUIT in the 
Command 
window. 

Exit 
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The Edit Menu Options:  

  

 و التحرير، لبرامج استخدامها يتم التي الوظائف توفر تحرير القائمة في الخيارات

 الكائن ربط تخلق التي خيارات أيضا القائمة هذا يحتوي. و التقارير ، الأشكال

 الخيارات 1.0 الجدول يسرد. الكائنات) OLE(  وتضمينها

  .ويصفها هذا الجدول . تحرير القائمة لوحة في مختلفة أوقات في تظهر التي

  Description  Menu Option  الوصف

 من محدود غير عدد يعكس

 أدخلت التي التغييرات

 الحالي تحرير على

 التي التغييرات. الدورة

 الماضي حفظ قبل أدخلت

Reverses an 
unlimited 
number of 
changes made in 
the current edit 
session. Changes 
made before the 

Undo  
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 خلال قدمت لو حتى ،

 ليست ، نفسها الدورة

  .للعكس قابلة

last save, even if 
made during 
the same session, 
are not 
reversible.  

 مرة عكسه تغيير يؤدي

  .أخرى

Performs a 
reversed change 
again.  

Redo  

 أو المحدد النص يزيل

 و الحالي المستند من الكائن

  .الحافظة في وضعه

Removes the 
selected text or 
object from 
current 
document and 
places it on the 
Clipboard.  

Cut  

 النص من نسخة يجعل

 ووضعه الكائن أو المحدد

 على

  .الحافظة

Makes a copy of 
the selected text 
or object and 
places it on the 
Clipboard.  

Copy  

 من الحالية المحتويات نسخ

  الحالي الإدراج إلى الحافظة

Copies the 
current contents 
of the Clipboard 
to the current 
insertion 
point.  

Paste  

 كائنات إدراج ل تستخدم

OLE التطبيقات من 

 عام في الأخرى

 تضمين يمكنك. حقل

.  ربطها مجرد أو كائنات

Used to insert 
OLE objects 
from other 
applications into 
a general 
field. You can 
embed objects 

Paste Special  
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 Visual برنامج

FoxPro 

 الكائنات من نسخة يخزن

.  الحالي الكائن في المضمنة

 عندما

 ، كائن يرتبط

FOXPRO إشارة يخزن 

 ل واسم المسار

  .فقط الأصلي الكائن

or merely link 
them. Visual 
FoxPro 
stores a copy of 
embedded 
objects in the 
current object. 
When an 
object is linked, 
FoxPro stores a 
path and name 
reference to the 
original object 
only.  

 دون المحدد النص يزيل

  .الحافظة إلى نسخها

Removes 
selected text 
without copying 
it to the 
Clipboard.  

Clear  

 في الكائنات كافة تحديد

 ويستخدم.  الحالي الإطار

 من كثير في الخيار هذا

 الأحيان

 تقرير تصميم و شكل في

 كافة يئة أو لنقل

  الوقت نفس في الكائنات

Selects all 
objects in the 
current window. 
This option is 
used often 
in form and 
report design to 
move or format 
all objects at the 
same 
time.  

Select All  

 ، بحث الحوار مربع يعرض

 لتحديد يستخدم والذي

Displays the 
Find dialog box, 
which is used to 

Find  
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 في نصية سلاسل

 إيجاد وتشمل. الملفات

 تجاهل على القدرة خيارات

 والتفاف ، القضية

 تتطابق ، خطوط حول

 إلى بحث و كلها، أقواله

  الخلف إلى أو الأمام

locate text 
strings in 
files. Find 
options include 
the capability to 
ignore case, 
wrap 
around lines, 
match entire 
words, and 
search forward 
or backward  

 البحث عمليةآخر يكرر

 نقطة الموضع من بدءا

 الحالي الإدراج

  المستند بداية من بدلا

Repeats the last 
Find starting at 
the current 
insertion point 
position 
rather than the 
beginning of the 
document.  

Find Again  

 الحوار مربع يعرض

 يستخدم والذي ، استبدال

 و مكان لتحديد

 في النص سلاسل استبدال

  الملفات

Displays the 
Replace dialog 
box, which is 
used to locate 
and 
replace text 
strings in files.  

Replace  

 الأول المقام في ستخدمي

 للذهاب التصحيح خلال

 في معين سطر رقم إلى

 الخيار هذا. البرنامج ملف

Used primarily 
during 
debugging to go 
to a specific line 
number in 
a program file. 

Go to Line  
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 عند استخدامها يمكن لا

 .على التفاف

 يكن لم ، الحال وبطبيعة(

 عند على التفاف لديك

  بك الخاص تحرير

This option 
cannot be used 
when word 
wrap is on. 
(Of course, you 
don't have word 
wrap on when 
you edit your  

 ، خاص لصق غرار على

 أن يتحمل لا أنه إلا

 و بالفعل، موجود الكائن

. الحافظة في تخزين يتم

 الخيار

 الحقول في الأجسام يضمن

 عندما.  العامة نوع

 كائن إدراج المختار،

 أن دون آخر تطبيق فتح

.  مرئي FoxPro تخرج

 بعد

 تطبيق في الكائن إنشاء

 يعود كائن إدراج ، آخر

 إلى

FoxPro إدراج و مرئي 

  مضمن أو مرتبط كائن

Similar to Paste 
Special, except 
that it does not 
assume that the 
object already 
exists and is 
stored on the 
Clipboard. The 
option 
embeds objects 
in general type 
fields. When 
chosen, Insert 
Object 
opens the other 
application 
without exiting 
Visual FoxPro. 
After 
creating the 
object in the 
other 
application, 
Insert Object 
returns to 

Insert Object  
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Visual FoxPro 
and inserts the 
linked or 
embedded 
object  

 كائن لتحرير خيارات يوفر

OLE المحدد.  

Provides options 
for editing a 
selected OLE 
object.  

Object  

 المرتبطة الملفات يفتح

)OLE  (من تمكنك و 

  . الارتباط تحرير

Opens linked 
files (OLE) and 
enables you to 
edit the link.  

Links  

 تحرير الحوار مربع يعرض

 تمكنك والتي ، الخصائص

 من

 ، السلوك على تؤثر

 الخيارات وحفظ ، والمظهر

 تحرير لل

  .النوافذ

Displays the 
Edit Properties 
dialog box, 
which enables 
you to 
affect the 
behavior, 
appearance, and 
save options of 
the edit 
windows.  

Properties  
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The View Menu Options:  

  

 .مفتوحا أحد كان إذا ، الحالي الجدول عرض ل المناسبة الخيارات القائمة تعرض

)  الأدوات شريط( واحد خيار القائمة تعرض ، ملف حاليا تستعرض لا كنت إذا

 التي ، الأدوات شريط الحوار مربع يفتح الذي

 كنت إذا أخرى، ناحية من. FoxPro يستخدمها التي المتاحة الأدوات أشرطة يسرد

  نموذج، تحرير أو جدول تتصفح بالفعل

  Description  Menu Option  الوصف

 ترتيب تعيين من تمكنك

  .النماذج في الجدولة

Enables you to 
set the tab order 

in forms.  

Tab Order  

 والعلاقات الجداول تعرف

 نموذج، في المستخدمة

  .تقرير أو ، مجموعة نموذج

Defines tables 
and relations 

used in a form, 
form set, or 

report  

Data 
Environment  

 عندما الرمز النوافذ يفتح

 أساليب بتحرير تقوم

  .الكائن

Opens the code 
windows when 
you are editing 

object methods.  

Code  
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 تحكم عناصر يفتح

 الأدوات شريط النموذج

مصمم  في وجودك أثناء

  النماذج

Opens the Form 
Controls toolbar 
while you are in 
the Form 
Designer.  

Form Controls 
Toolbar  

 عناصر التقرير يعرض

 والتي ، الأدوات شريط

 إضافة من تمكنك

  تقرير ل ضوابط

Displays the 
Report Controls 
toolbar, which 
enables you to 
add 
controls to a 
report  

Report Controls 
Toolbar  

 الأدوات شريط يفتح

 تساعدك والتي تخطيط،

  الضوابط محاذاة على

Opens the 
Layout toolbar, 
which helps you 

align controls  

Layout Toolbar  

 لوحة الأدوات شريط يفتح

 من تمكنك والتي ، الألوان

 تحديد

 والخلفية الأمامية الألوان

  . تحكم لعنصر

Opens the Color 
Palette toolbar, 
which enables 
you to select 
foreground and 
background 
colors for a 
control.  

Color Palette 
Toolbar  

 خطوط عرض تبديل

  .وخارجها الشبكة

Toggles the 
display of grid 

lines on and off.  

Grid Lines 

 والطول، ، الموقف يعرض

 المحدد الكائن من والعرض

 أو

  الحالة شريط في تشكل

Displays the 
position, height, 
and width of the 
selected object 
or 
form in the 

Show Position 
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status bar.  
 الذي الحوار مربع يعرض

 التي الأدوات كل يسرد

 أو FoxPro يستخدمها

 لتخصيص لك يتيح مما

 ، الأدوات أشرطة أزرار

 بك الخاصة وخلق

  . الخاصة

Displays a 
dialog box that 
lists every 
toolbar used by 
FoxPro, 
enabling you to 
customize the 
buttons in 
toolbars and to 
create your 
own.  

Toolbars 
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The Format Menu Options:  

  

 الخصائص البادئة المسافة الخط في تتحكم التي الخيارات من عادة يتكون تنسيق القائمة

 استخدام عند ذلك، ومع ، المتاحة الإضافية الخيارات تصبح. والنص، والتباعد ،

  المصممين مختلف

  :وهي موضحـة في الجدول التالي

  Description  Menu Option  الوصف

 محاذاة التي الخيارات يفتح

  المحددة الكائنات

Opens options 
that align 
selected objects  

Align  

 حجم التي الخيارات يفتح

  الكائنات تحديد

Opens options 
that size selected 

objects  

Size  

 ضبط التي الخيارات توفر

 المختارة بين الأفقي التباعد

  .الكائنات

Provides options 
that adjust 
horizontal 
spacing between 
selected 
objects  

Horizontal 
Spacing  

 ضبط التي الخيارات توفر

 بين العمودي التباعد

Provides options 
that adjust 
vertical spacing 

Vertical Spacing  



 E-mail :mebarkimouaadh@Gmail.com Page 

37 

Microsoft Visual FoxPro 9.0 كتاب تعلم    

Tel :+(213)792306382 رآ�                                                    :إ��اد����ذ   

 between selected  المختارة الكائنات
objects.  

 إلى المحدد الكائن ينتقل

 الكائنات من العلوي الجزء

  .النموذج في

Moves the 
selected object 

to the top of the 
objects in a 

form.  

Bring to Front  

 إلى المحدد الكائن ينتقل

 الكائنات من الخلفي الجزء

  النموذ في

Moves the 
selected object 
to the back of 

the objects in a 
form.  

Send to Back  

 الأجسام تكون عندما

 الزاوية تتأهب ، المتحركة

 لل اليسرى العلوية

 عند الشبكة تقاطع أقرب

  .الماوس زر تحرير

When you are 
moving objects, 
repositions the 
top-left corner 
to the 
nearest grid 
intersection 
when the mouse 
button is 
released.  

Snap to Grid  

 متباعدة كيفية يحدد

   الأفقية و الرأسية الشبكات

Determines how 
far apart the 
vertical and 

horizontal grids 
are.  

Set Grid Scale  
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The Tools Menu Options:  

  

 ل المعالجات من بدءا ، مبرمج الأدوات من متنوعة مجموعة أدوات القائمة تقدم

  .أدوات القائمة في الخيارات التالي الجدول ويحدد .المصحح

 Description Menu Option الوصف

 إلى الوصول يوفر و القوائم

  FoxPro معالجات

Lists and 
provides access 
to Visual 
FoxPro's 
wizards 

Wizards 

 توضيح الأول المقام في

 النص حقول الشيكات

. والمذكرات  

Primarily spell-
checks text 
fields and 
memos. 

Spelling 

 وحدات على ويحافظ يحدد

المفاتيح لوحة الماكرو  

Defines and 
maintains 
keyboard 
macros. 

Macros 
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 فئة أي محتويات يفحص

و خصائصه لعرض  

 الفعلية رمز حتى أو طرق

. الكائن لإنشاء المستخدمة  

Examines the 
contents of any 
class to view its 
properties and 
methods or even 
the actual code 
used to create 
the object. 

Class Browser 

 تنسيقه البرنامج ملفات

والرسملة الطعج لإضافة  

Reformats 
program files to 
add indenting 
and 
capitalization. 

Beautify 

 هذا.  المصحح نافذة يفتح

لل بديل تحسن  

 نافذة وتعقبها التصحيح

 للمتغيرات النوافذ يضيف

، ساعة  

 والدعوة ، المحليين السكان

 تتبع على والقدرة المكدس،

وتحليل الأحداث  

الاختبا خلال التغطية  

Opens the 
Debugger 
window. This 
improved 
replacement for 
the 
Debug and 
Trace window 
adds windows 
for watch 
variables, 
locals, call stack, 
and the 
capability to 
track events and 
analyze 
coverage during 
testing. 

Debugger 

 Provides access إلى الوصول يوفر
to Visual 

Options 
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FoxPro  خيارات 

. البصرية التكوين  

FoxPro 
configuration 
options. 
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Default Macro Definitions for Function Keys:  

Command  Key  
SET  F2  

LIST  F3  
DIR  F0 

DISPLAY 
STRUCTURE  

F5  

DISPLAY STATUS  F6  
DISPLAY MEMORY  F7  

DISPLAY  F8  
  F9 
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The Program Menu Options:  

  

 تشغيل و تجميع ترتبط التي البرنامج خيارات ستة من القائمة وتتكون

  .التالي خيارات البرنامج الجدول يصف. البرنامج

  Description  Menu Option  الوصف

 من المحدد البرنامج يدير

  الحوار مربع

Runs a program 
selected from a 
dialog box.  

Do  

 Cancels the  . الحالي البرنامج يلغي
current 
program.  

Cancel  

 من الحالي البرنامج يستأنف

  .التنفيذ وقف مع دولة

Resumes the 
current 
program from a 
suspended state.  

Resume  

 من الحالي البرنامج توقف

 إزالته لا ولكن تنفيذ

  .الذاكرة من

Stops the 
current 

program from 
executing but 

does not remove 
it 

from memory.  

Suspend  

 إلى مصدر ملف يترجم

  الكائن رمز

Translates a 
source file into 
object code.  

Compile  
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. (  الحالي البرنامج يدير

 كما القائمة في الخيار يظهر

 ، يفعل

  ). PRG اسم يليه

Runs the 
current 

program. (The 
option appears 
in the menu as 

Do, 
followed by the 
name of the 
PRG.)  

Run  
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Menu OptionsThe Window :  

  

 القائمة تقدم.  الشاشة على المفتوحة النوافذ تدير التي الخيارات إطار القائمة تحتوي

.  النوافذ خلال من دورة و ، واضح ، إخفاء جميع، ترتيب من تمكنك التي الخيارات

 تحقيق من تمكنك القائمة ذلك، إلى بالإضافة

  .النافذة ياراتخ التالي الجدول يسرد.  حاليا مفتوح نافذة أي الأمام إلى

  Description  Menu Option  الوصف

 Arranges open   المفتوحة النوافذ يرتب .
windows as non-
overlapping tiles.  

Arrange All  

 ولكن النشط الإطار يخفي

  الذاكرة من إزالته لا

Hides the active 
window but does 
not remove it 
from memory  

Hide  

 Windows يعرض

  . كافة تعريف

Displays all 
defined windows  

Show All  

 مساحة من النص مسح

 الانتاج التطبيق أو العمل

Clears text from 
the application 
workspace or 

Clear  
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 الحالي

  نافذة

current output 
window.  

 مفتوحة نافذة من يتحرك

 مما ، أخرى إلى واحدة

 التالي الإطار يجعل

  .نشط واحد

. 
Moves from one 
open window to 
the next, making 
the next window 
the active one.  

Cycle  

  Description  Menu Option  وصف

 نشطة الأوامر إطار يجعل

 ، القمة إلى ويجلب

  .الأمر لزم إذا فتح

Makes the 
Command 
window active 
and brings it to 
the top, 
opening it if 
necessary.  

Command 
Window  

 بيانات الدورة إطار يجعل

 ، القمة إلى ويجلب نشطة

 يخدم. الأمر لزم إذا فتح

 أداة باعتباره الإطار هذا

 ل قيمة

 هي التي الجداول مراقبة

 من مجال كل في مفتوحة

  . 32،767 العمل مجالات

Makes the Data 
Session window 
active and brings 
it to the top, 
opening it if 
necessary. This 
window serves as 
a valuable tool 
for 
monitoring which 
tables are open in 
each of the 32,767 
work areas.  

Data Session  

 نوافذ تسعة أول يعرض

 من أكثر كان إذا. محددة

Displays the first 
nine defined 
windows. If more 

<Window List> 
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 تسعة

 و النوافذ، تحديد تم وقد

 ل ئيةالنها المباراة

Windowsappears 
 . أكثر الخيار -

 إطار أي إلى التركيز لتغيير

  . اسمها على انقر ببساطة ،

than nine 
windows have 
been defined, a 
final option-More 
Windowsappears. 
To change focus 
to any window, 
simply click its 
name.  

  

  

  

  

  

  

  

  

  

  

  

  



 E-mail :mebarkimouaadh@Gmail.com Page 

47 

Microsoft Visual FoxPro 9.0 كتاب تعلم    

Tel :+(213)792306382 رآ�                                                    :إ��اد����ذ   

Values Found in the Flag Column of the Grid in the 
Code Analyzer 

Meaning Flag 
Header H 
Form K 

Visual Class Library V 
Program P 

Menu (.MNX) M 

Menu (.MPR) m 

Query Q 
Report R 
Label B 

Library L 
Format F 

Database d 
Associated Table t 

Index I 
File x 

Text File T 
Application Z 

Icon i 
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 ):Functions(الدوال

هي أحد أهم مكونات لغة البرمجة وهي الوسيلــة السريعــة لتنفيذ العديد من 

المهام فكما في علم الرياضيات عرفنا مفهوم الدوال كالدالة التربيعية والدالة 

اللوغارتيمية، فإن هذا المفهوم انتقل إلى عالم البرمجة بصورة مشاــة تماما حيث 

لوظائف التي لها اسم محدد وتأخذ بيانات لتعمل لغة البرمجة على العديد من اتحتوي 

عليها وتعطى نتيجة محددة،أي أنــه للتعامل مع الوظيفــة او الدالــة ينبغي 

معرفــة أسمها وفائدا والمعطيات التي تستقبلها والقيم التي تعيدها ، بعض الدوال لا 

  .تأخذ معطيات وبعضها لا يرجع قيم 
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 :)Structure Programming(الهيكليــةمفهوم البرمجة 

ينص هذا المفهوم على ان البرنامج مكون من مجموعــة من الوظائف تنادي بعضها 

البعض لتؤدي الهدف المطلوب من البرنامج، ومن البديهي أن يحتوي البرنامج على 

نقطــة بدايــة من خلال الدالة الأساسية أو الرئيسيــة في البرنامج ،ونظرا لأن 

ف فإنــه يطلق على البرنامج اسم الإجراء البرنامج يحتوي على العديد من الوظائ

Procedureومن هنا فإن البرنامج قد يحتوي على مجموعة من Procedures ،

يحتوي على دالة أو مجموعة  Procedureالتي تنادى بعضها البعض بحيث أن كل 

  .من الدوال

 ):Variables(المتغيرات:01

اسب ، فإنك تقوم بتخزين هذه المتغيرات هي أماكن للتخزين الموقت داخل ذاكرة الح

المعلومـــة وهي الطلب الذي طلب منك في ذاكرة وتعمل على هذا الطلب،إذن 

وبمجرد  Ramفإن الحاسب يقوم بتخزين المعلومات مؤقتا في الذاكرة العشوائيــة 

  :الإنتهاء من الحاجــة لهذه المعلومات فإنــه بمسحها أي أنــه

  .ؤقت للمعلومات داخل الذاكرة العشوائيــةيقوم الحاسب يقوم بتخزين الم •

تحمل هذه المعلومات كل على حدة اسم يطلق عليــه اسم المتغير مما يسهل  •

 .الوصول لهذه المعلومات

 بمجرد انتهاء الحاجة لهذه المعلومات أو المتغيرات فإنه يتم مسحها  •

تغير الحرفي المتغيرات هي أنواع وليست نوع واحد فهنالك المتغير الرقمي و الم •

 الخ...وغيرها

  :ومن أهم أنواع المتغيرات نذكر
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وهو وعاء لتخزين سعة أي نوع من البيانات سواء حروف ارقام : المتغير الحرفي •

  أو رموز

وعاء لتخزين لا يستقبل سوى الأرقام والعلامات العشريــة : المتغير الرقمي •

 .وبعض العلامات التي تفيد معنى الرقم

 وهو وعاء لتخزين التاريخ:التاريخيالمتغير  •

 )لا/نعم(وعاء لحرف واحد لتخزين قيم من قيمتين :المتغير المنطقي •

 وهي شبيه بالمتغير العرفي إلا أن سعة تخزين البيانات فيه أكبر:الوعاء الشامل •

  :يجب معرفــة كيفيــة معرفــة: كيفيــــة التعامل مع المتغيرات

 تحديد العمر الزمني للمتغير •

 تحديد اسم المتغير •

 تحديد نوع المتغير •

 الوصول إلى البيانات داخل المتغير •

 تغيير قيمة المتغير •

  :تحديد العمر الزمني للمتغير:01

هذا مفهوم بسيط ولكن لايمكن عرضه إلا لانه يعتمد على مفهوم اخر وهو نمط 

  .البرمجة

  :تحديد إسم المتغير ونوعه وقيمتــه:02

ثم القيمــة = د كتابــة الإسم يليــه علامــةيتم ذالك ببساطــة بمجر

 يحمل القيمــة NyNameالتي يحملها المتغير فمثلا للاعلان عن متغير اسمــه 
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"mebarkimouaadh"ويكون كا التالي:  

"mebarkimouaadh"NyName 

بين علامتي تنصيص وذالك يعني أن  mebarkimouaadhونلاحظ وضع الاسم 

المتغير نوعــه حرفي ولإعلان المتغير الرقمي يكون بنفس الطريقــة إلا أنه لا 

  NyNum1=3 نستعمل علامتي التنصيص

 MyNum1في المتغير  3وهنا وضعنا القيمــة الرقميــة 

يث يعلن وبالنسبــة للمتغير المنطقي فإن المثال التالي يبين كيفيــة استخدامه ح

 Falseوالأخر على القيمــة Trueمتغيرين منطثيين احدهما يحتوي على قيمــة 

MyTrue=.T. 

MyFalse=.F. 

وللتعبير عن   .T.نكتب الحرف Foxproفي Trueونلاحظ للتعبير عن القيمــة 

 .F.نكتب الحرف FALSEالقيمــة 

والأن سوف نإخذ مثال يوضح مفهوم التعامل مع المتغيرات ويتعرض أيضا للمتغيرات 

  Foxproالتاريخيــة وبعض الوظائف الجديدة 

  :التالينقوم بكتابــة الكود 
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SET COLOR To W/N 
CLEAR 
Name = "Mebarkimouaadh" 
Age = "21" 
Telephone = "+(213)0792306382" 
Years = 10 
Money_Per_Year = 100000 
Total = years * money_per_year 
Mydate = Date() 
Mytime = Time() 
? "Name := " + name 
? "Age:= " + age 
? "Telephone :=" + telephone 
? "Total := " + STR(total) 
? "Date:= " + DTOC(myDate) 
? "Time :=" + mytime 

  فنلاحظ أن البرنامج يعمل بسلاســة خلال الزرونقوم بتنفيذ البرنامج من 
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  :والأن سوف نستعرض المفاهيم الجديدة في هذا المثال

أي أن كتابــة المتغير  Case Sensitiveليست  Foxproلغة البرمجة  •

 .بحروف كبيرة أو صغيرة لا يؤثر فيها

يمكن إجراء العماليات الحسابيــة على المتغيرات الرقميــة كما في حساب  •

( والعلامات الأساسيـة هي totalقيمــة المتغير 

 ).القسمـة/الضرب/الطرح/الجمع

 MyDateتعطي تاريخ اليوم وقد تم تسجيله في المتغير  ()Dateالدالة •

 تعطى الوقت في صورة متغير حرفي ()Timeالدالة •

تحول المتغير الرقمي إلى متغير حرفي وقد حدث ذالك عند تحويل  ()STRالدالة  •

 قبل عرضـه TOTALالمتغير 

تحول المتغير التاريخي إلى متغير حرفي كما تم عند تحويل المتغير  ()DTOCالدالة •

Mydate 

  والأن ننقل إلى مثال جديد من أجل التعرف أكثر المتغيرات

  :والأن نقوم بنسخ الكود التالي

SET COLOR To W/N 
CLEAR 
mystr = "mouaadh" 
? mystr 
? UPPER(MYSTR) 
? LOWER(MYSTR) 
? LEFT(MYSTR,3) 
? RIGHT(MYSTR,3) 
? LEN(MYSTR) 
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فنلاحظ أن البرنامج يعمل  ونقوم بعمليـة رن للبرنامج من خلال الزر 

  بسلاســة دون أي أخطاء

 

واسناد له  Mystrنلاحظ أن من خلال هذا المثال تم إعلان عن متغير حرفي يسمى 

  :وتم النعرض لستة دوال "mouaadh" القيمــة

  .تقوم بتحويل العبارة الحرفيـة إلى حروف كبيرة:UPPERالدالة:01

  .تقوم بتحويل العبارة الحرفية إلى حروف صغيرة:LOWERالدالة02

بإستخراج جزء من العبارة الحرفية ابتداء من اليسار وتأخذ تقوم : LEFTالدالة 03

  .ارة الحرفية وعدد الحروف المطلوب اخذهاهذه الدالة إسم العب

  .الا أا تبدأ بأخذ الحروف من اليمينLEFT دالةتماما مثل ال:RIGHTالدالة 00
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 تأخذ جزء من العبارة الحرفية عن طريق تحديد ثلاثـة معطيات:SUBSTRالدالة:5

الاول هو إسم المتغير االذي يحتوي على العبارة الحرفية والثاني نقطة بداية أخذ الحروف 

  من اليسار و الثالث عدد الحروف التي يتم أخذها

  .تعطي هذه العبارة طول المتغير: LENالدالة :06
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 : )Procedures(ملفات الإجراء

ملفات الإجراء هي ملفات التي يتم فيها تخزين تعليمات البرنامج وتأخذ هذه الملفات 

، وبذالك يمكننا الإحتفاظ بالأمثلـة التي قمنا بعرضها لتنفيذها في أي .PRGالإمتداد 

  وقت وكذالك تعديلها وتطويرها وهنالك عدة طرق مختلفـة لانشاء ملفات الإجراء

  

من خلال  Ctrl+Nلخطوة الاولى من خلال الضغط على ونلاحظ انه يمكن إختصار ا

  .لوحة المفاتيح

وذالك عن  Command Windowالطريقة الثانية هي من خلال نافذة الأوامر 

 MODIFY COMMANDطريق الأمر 
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   :ملاحظة مهمــة جدا

عند تنفيذ أي أمر بوضع الأمر المقابل له تلقائيا داخل نافذة  FoxProيــقوم   

الأوامر لذالك إذا قمت بإنشاء ملف الإجراء من خلال الطريقة الأولى فسوف نجد أن 

  .قد تم كتابته بصورة تلقائية داخل نافذة الأمر  MODIF COMMANDالأمر 

  نقوم الأن بكتابة الكود 

  

SET COLOR TO W/B  
CLEAR 
? "Visual FoxPro"" 
WAIT 
SET COLOR TO W/n 
CLEAR 

  :ثم نقوم بعمليــة الحفظ كما هم موضع في الصورة التاليــة
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  او من خلال الضغط على الزر

  foxproثم نقوم بحفظ داخل ملف قمنا بإعداده في سطح المكتب بعنوان 
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كما هو موضح في الصورة التالية 
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 Doالأمر 

فرعي ويقوم بتنفيذه وعند  Procedure(.PRG)يقوم هذا الأمر بمنادة ملف 

الإنتهاء من التنفيذ يعود التحكم للبرنامج الرئيسي لمتابعــة تنفيذ الأوامر التي تلي 

  ذالك الأمر
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  :Return الأمر

كان هذا الملف  ق إذاProcedureيقوم هذا الأمر بإاء التنفيذ داخل الملف 

الرئيسي فإنــه يتم ذا الأمر أاء البرنامج وإذا كان الملف ملف فرعي فإنه يتم 

  العودة للملف الذي قام بمناداته لمتابعـة تنفيذ العمليات

  :ملاحظـــة

يمكن أن ينادي الملف الفرعي ملف أخر،أي يمكن نقل التحكم أكثر من مرة من 

والعودة خطوة للخلف من خلال الامر  Doالأمر  لآخر خلال) ملف إجراء(برنامج 

Return 
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  : Procedureالأمر 

وههذا الإجراء )PRG.(يقوم هذا الأمر بإعلان إجراء صغير داخل الإجراء الكبير

 Doيمكن مناداته كما يتم مناداة أي إجراء آخر بإستخدام لأمر 

على مجموعة من الاجراءات الصغيرة بجانب مجموعة ) PRG.(ويحتوي الإجراء الكبير 

من الوظائف لكن الاجراء الصغير لا يحتوي على أي إجراءات داخليـة وكذالك لا 

الا أنه لا Returnيحتوي على وظائف داخليــة، ينتهي إعلان الإجراء بالأمر 

، الفرق Functionيرجع قيمــة كما في الحالــة الدالــة أو الوظيفــة 

ين الإجراء والدالــة من حيث ارجاع القيمــة هو الفرق فقط من الناحيــة ب

الأكادميــة وليس من الناحيـة العمليــة بمعنى يمكن عمل إجراء ويرجع 

 قيمــة ويمكن عمل دالــة ولا ترجع القيمــة
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: Function الامر 

 لغة دوال احدك مباشرة استخدامها يمكن جديدة دالة باعلان الامر هذا يقوم

Foxpro قبل من موجود غير الجديدة الدالة اسم يكون ان ،ويشترط الاساسية  

  :ملاحظــة

 الحروف تابةك خلال من برو سكفو فيجوال لغة اوامر باختصار نقوم ان يمكن

 كتبي ان يمكن procedure الامر المثال ،سبيل فعلى الامر من الاولى الاربعة

proc والامر function يكتب ان يمكن func  
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  scope of variables & functions : والدوال المتغيرات مجال

 الدوال او المتغيرات لهذه العمل مجال تحديد الدوال او المتغيرات تعريف اثناء يمكن

 ذلك نفهم ولكى البرنامج داخل الدالة او للمتغير، الانتشار هو باال والمقصود

 وهى التعليمات او الجديدة الاوامر من موعة التعرض ينبغى

Local,Private,Public & Static ،مجال تحدد اوامر اربعة وهى 

  .الدوال انتشار مجال لتحديد يستخدم Static والامر المتغير انتشار

 يعنى )PRG.ملف( بيرك اجراء داخل المعرفة الدوال قبل Staticالامر استخدام

 ثركا هناك آان واذا الاجراء او الملف هذا، داخل الا معرفتها يتم لن الدالة هذه ان

 هذه بوجود تشعر لن الاخرى الملفات هذه فان البرنامج داخل Prg. ملف من

  .الدالـــــة

 هذا ان يعنى مرة اول تعريفه عند اى المتغير اعلان قبل static الامر استخدام

 ملفات انتك سواء الاجراءات افةك امام متاح سيظل وانه قيمته تتغير لن المتغير

.Prgولكن المتغير هذا قيمة تعرف ان البرنامج داخل دوال او فرعية اجراءات او 

 انه يعنى المتغير امام، local الامر استخدام قيمته فى تعدل ان امامها متاح يكن لن

 يتم التى الدوال( ة فرعي دوال لاى متاح وغير داخلها تعريفه تم التى الدالة داخل

 تنفيذ انتهاء بمجرد فانه ذلككو معه تتعامل ان) تعمل التى الدالة داخل من مناداا

  .متاح غير ويصبح المتغير حذف يتم فانه المتغير هذا اعلنت التى الدالة

 الفرعية للدوال و الدالة داخل متاح المتغير ان يعنى privateالامر استخدام 

 انتهاء بمجرد فانه ذلككو معه التعامل الاخرى البرنامح اجزاء لبقية مسموح وغير

  متاح غير ويصبح المتغير حذف يتم فانه المتغير هذا اعلنت التى الدالة تنفيذ
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 ويمكن البرنامج اجراء آامل داخل متاح المتغير ان يعنى public الامر ستخداما

  البرنامج فى جزء اى من المتغير قيمة تعديل

  :ملاحظـــــة

 اسناد مع المتغير اسم قبل استخدامها يمكن بالمتغيرات الخاصة scopeاال اوامر

  .له قيمة اى اسناد بدون المتغير اسم مع او السطر نفس فى له قيمة

 مابداخلهما ان تعنى [] العلامتين و ضرورى مابداخلهما ان تعنى <> العلامتين

 تفصلها التى الخيارات بين مما واحد اختيار يتمأي ) او(تعنى / والعلامة اختيارى

  ./ العلامة
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  Control Structure: التحكم يباتكتر

 من المطلوبة النتائج على الحصول يمكن خلالها من التى البرمجة سمات اروع احدى

-forو  if-else-endif يباتكالتر هذه واهم تابتهاك يتم التى البرامج

endfor  وdo while-enddo  و  case-endcase.  

 تنفيذ يتم يتحدد لم واذا محدد شرط تحقق اذا معينة تعليمات تنفيذ if جملة تتيح

  .اختيارية وهىelse جملة تلى التى التعليمات

  .المرات من محدد عدد العمليات تنفيذ لتكرار تستخدم for جملة •

 شرط هناك ان مادام العمليات من عدد لتنفيذ تستخدم Do whileجملة  •

  .متحقق ما

 متغيرات على المبنية الاحتمالات وغالبا الاحتمالات فى تستخدم caseجملة  •

 .رقمية

  * المشروط التفرع

If <condition - expression> 
……..code 
else 
……..code 

Endif  
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  * الرقمية المتغيرات خلال من المشروط التكرار

for <Nvariable> = <Nvalue> to <Nvalue> 
step <Nvalue> 
…..code 
endfor 

 * المشروط التكرار

do while <condition - expression > 
…….code 

Enddo  

  

  

  * المتغيرات خلال من المشروط التفرع

do case 
case <variable> = value 
…….code 
case <variable> = value2 
……..code 

endcase  
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  Expression : التعبيرات

 التعبير وجد واذا متغيرات عدة من معينة نتيجة على للحصول التعبيرات تستخدم

 سؤال انهك conditionفانه يسمى  whileاو الجملـة   if جملة مع

اذا لم  .F. او الشرط تحقق اذا  .T.النتيجـة  تعطى التى البرمجة للغة او للحاسب

 ثالث احتمال هناك الواقع فى لكن اخرى نتيجة هناك ليس انه يظن البعضيتحقق 

  .سليم غير التعبير انك اذا وذلك خطا رسالة اى ERROR على تحصل ان وهو

 برو سكفو فيجوال البرمجة لغة فان له قيمة اسناد بدون مرة اول اعلانه عند المتغير

 فى تضع سوف ولهذا يحملها التى للقيمة تبعا المتغير، نوع تحدد لانه نوعه تعرف لن

 .F. هى الفيمة وهذه منطقية قيمة المتغير

 له نسند فاننا لاشى المتغير قيمة جعل اردنا واذا المتغيرات مع العمل اثناء ولكن

  .والتي تعني العدم NULL القيمة

 من الانتهاء يتم حتى الاخر تلو تعليمة تعليماته تنفيذ يتم فانه البرنامج تشغيل عندو 

 تابةك تم فانه البرنامج عمل استمرار ولضمان البرنامج من الخروج ثم ومن التنفيذ

 ويعنى شرط ابسط  .T. هو الشرط ويكون enddoو  while بين التعليمات

  .متحقق دائما الشرط ان

كانت  سواء الحلقة داخل العمل ينهى فانه الحلقة داخل استخدم اذا EXIT :الأمر 

FOR  او    DO WHILE  الحلقة بعد لما التنفيذوبنقل.  

 مرحلة الاولى للمرحة التنفيذ ينقل فانه الحلقة داخل استخدم اذا  LOOP :الأمر 

  الامر ذلك تلى التى التعليمات ويهمل الشرط اختبار
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  : مثال

التي   Windowsأو إبدأ حسب    Démarrerاو  Starنقوم بالنقر على 

  :تستعملها أنا أستعمل النسخة الفرنسيــة ونتبع الخطوات التاليــة

 Démarrerنقوم بالنقر على زر •

 Tous les Programmesنقختار  •

 Microsoft Visual FoxPro 9.0 ثم نختار •

  :كما هو مبين في الصورة التاليــــــــة

 

 Foxpro 9.0فتظهر لنا الشاشــة الأساسية الخاصة ب  
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   ..Newثم نحدد   Fileثم نختار 

 New fileثم نضغط على  programثم نحدد 

 :كما هو مبين في الصورة التاليـــــــة
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  ثم نقوم بكتـــــــــابــه الكود كما هو مبين في الصورة 

  

  ليوالكود هو كا التا
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do while .T. 
set color to bg+/b,gr+/rb 
clear 

@1,2 say " هل لغة البرمجة Visual FoxPro من إنتاج شركة 

Microsoft ؟" font "",30 

@7,12 prompt " صحيح " font "",30 

@10,12 prompt " خطأ"  font "",30 

@13,12 prompt "خروج " font "",30 
menu to mymenu 
do case 
case mymenu = 1 
myop1() 
case mymenu = 2 
do myproc2 
case mymenu = 3 
exit 
endcase 
enddo 
set color to w/n 
clear 

  font "",30 "مع السلامة "?
return 
function myop1() 
set color to w/r 
clear 

  font "",30 "احسنت الاختيار"?
wait 
return 
proc myproc2 
set color to w/n 
clear 

  font "",30 "الاجابة خطا"?
wait 
return 
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   ببرنامج من خلال الزر   Runثم نقوم بعمليــة 
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 say للامر تعرضنا اننا الا شرحة تم ما على بسيط تطبيق اول هو البرنامج وهذا

 جملة فاول )العمود ثم السطر(  دمحد مكان فى الشاشة على محدد نص يعرض والذى

say  الأمر  الثانى والعمود الاول السطر فى سؤال تعرضprompt  مشابه 

   المضىء بالشريط تعمل التى القائمة خيارات لعمل يستخدم انه الا  say  لامر

 نتيجة يحمل سوف الذى الرفمى المتغير لتحدد يستخدم menu to الامر

 به قام الذى للاختيار التنفيذ لاستجابة انه ونلاحظ المستخدم به قام الذى الاختيار

 بمناداة قمنا اخرىومرة Do الامر خلال من فرعى اجراء بنداء مرة قمنا المستخدم

  بتعريفها قمنا فرعية دالة
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  :ملفات البيانات

 وهى DBF. الامتداد يحمل ملف هو برو سكفو فيجوال داخل البيانات ملف

 الذى الشخص يقوم مواصفات الملف ولهذا) DataBase File(:ـل اختصار

 الحقول اسماء عن عبارة وهى Details تسمى المواصفات هذه بتحديدها ينشئه

Data Fieldsللحقل التخزينية والسعة) وغيرها – رفمى – حرفى(وانواعها.  

 بحاجة فانت الاصدقاء هواتف ارقام يحمل بيانات ملف انشاء تود نتك اذا فمثلا

  الاسماء تسجيل الى الاقل على

 يحمل والاخر الاسم يحمل احدهما حقلين البيانات ملف فى نضع وهنا الارقام بجانبها

  الحقل نوع ويكون الهاتف رقم

 ليس الهاتف رقم لان حرفى ايضا والاخر حروف عن عبارة الاسم لان حرفى الاول

 مثلا الاسم حق سعة ويكون عليه الحسابية لاجراءالعمليات نحتاج ولن حسابى رقم

  .ذالك من ثركا نحتاج اننا اظن ولا 15 الهاتف رقم وحقل حرف 50

 وقت اى فى لاسترجاعها البيانات حفظ على فقط مهمته تقتصر لا البيانات ملف ان

 البيانات قواعد نظم وفى المطلوبة المعلومة على للحصول داخله البحث لنا يتيح بل

 من المعلومات استخلاص على القدرة فى البيانات ملفات من العديد على تشتمل التى

  .الاهمية غاية فى امر معا تعمل التى الملفات هذه

 العمل فان البيانات قواعد تظم جميع فى شائعة عملية هى البحث عملية انتك ولما

 العملية تلك سرعة زيادة على

 فهرسة على تقوم والتى الفهارس ملفات مفهوم نشأ هنا ومن الاهمية غاية فى امر

 الفهارس ملفات فى البحث عملية وتكون معين حق بيانات خلال من الملف بيانات
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 او الاستعلام انك ولما،  مباشرة بصورة البيانات ملف فى البحث من بكثر اسرع

 لاعلى يصل وقد احيانا البساطة فى غاية يكون قد البيانات ملف داخل البحث

 مستويات

 والتى الاستعلام ملفات تشمى لملفات الحاجة نشأت الكبيرة الانظمة فى التعقيد

  البحث عملية على تساعد

 استخراجها يمكن التى التقارير فى تكمن البيانات قواعد انظمة عمل ثمرة لان ونظرا

 بتلك تقوم التى التقارير ملفات وجود فان لذا فائقة ويسرعة مباشرة البيانات من

  .الاداء وسهولة لسرعة الوقت نفس فى وضروريا طبيعيا امرا انك المهمة

 مفهوم نشاء هنا من الاداء لكفاءة بينها روابط توجد قد البيانات ملفات ان وحيث

 رئيسية بصفة وتساهم لكالمشا من ثيرك حل الى تؤدى والتى الجدوال بين العلاقات

  .علاقية بيانات قواعد تسمى السبب لهذا والتى البيانات قواعد امبراطورية فى

 قواعد ادارة نظام على باحتوائها متكاملة برمجة لغةك برو سكفو فيجوال تتميز

  .تطوير محيط داخل متكاملة بيانات

 البيانات ملفات لانشاء اللغة تطوير محيط عن للخروج حاجة هناك يجعل لا مما اللغة

 داخل مباشرة معه التعامل يمكن شىء لك ان حيث التقارير او والفهارس والاستعلام

  .الكفاءة من جدا عالى مستوى على معها والتعامل البيانات برمجة تتيح اا ماك اللغة

 سعة وتتيح فاعلية ثركا بيانات قواعد تحتاج والتى الكبيرة الانظمة بناء حالة وفى

أو SQLالى البيانات قاعدة تحويل يمكنك حيث ممكن ذلك فان عالية تخزين

Oracle برو سكفو فيجوال بلغة بتطويره تقوم هو ماك البرنامج يظل ذلك ومع 
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 ونظام برمجة لغة اعتبارها يمكن برو سكفو فيجوال ان الواقع فى التعليمات بنفس

 .الوقت نفس فى بيانات قواعد ادارة
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   )جدول( البيانات ملف انشاء

  :التالية الخطوات اتبع جديد بيانات ملف انشاء يتم لكى

التي   Windowsأو إبدأ حسب    Démarrerاو  Starنقوم بالنقر على 

  :تستعملها أنا أستعمل النسخة الفرنسيــة ونتبع الخطوات التاليــة

 Démarrerنقوم بالنقر على زر •

 Tous les Programmesنقختار  •

 Microsoft Visual FoxPro 9.0 ثم نختار •

  :كما هو مبين في الصورة التاليــــــــة

 

 Foxpro 9.0فتظهر لنا الشاشــة الأساسية الخاصة ب  
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  ..Newثم نحدد   Fileثم نختار 

  :، كما هو موضح في الصورة التالية New fileثم نقوم بتحديد Tableثم نختار 

  



 E-mail :mebarkimouaadh@Gmail.com Page 

80 

Microsoft Visual FoxPro 9.0 كتاب تعلم    

Tel :+(213)792306382 رآ�                                                    :إ��اد����ذ   

نقوم بعملية حفظ التطبيق على مجلد على سطح المكتب او في أي مكان من جهاز  ثم

الحاسوب قمنا من إنشائه من قبل 

  

 .نقوم بعملــة الحفظثم 

 ونقوم بالتعليم كما هو موضح في الصورة التاليــة
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لها مواصفات تمكنك من تحديد البيانات المدخلـة   Fieldsوكما نرى فالحقل 

  .ولنبدأ بأول حقل

وهو يطلب اسم للحقل سوف نكتب  Nameسوف نجد مستطيل تحت تبويب 

name  نلاحظ أن اسم الحقل يستخدمــه المبرمج في تكوين العلاقات

ذا والإستعلامات والتقارير بينما يعني للمستخدم عنوان المعلومة المراد إدخالها ول

يمكننا أ  name:نستخدم النماذج مستخدمين عناوين سهلـة للمستخدم فـ

  نكتبها مسلسل بمعنى رقم تسجيل

  النوع ومنها Typeننتقل إلى خانة تبويب 

01:Character  حرفي وتقبل جميع ما يمكن إدخالــه من لوحـة المفاتيح

  .حروف و أرقام ورموز
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02:numeric:ــه من لوحة المفاتيح من رقمي يشمل جميع ما يمكن إدخال

  حروف و أرقام ورموز

03:Date:خانات ويأخذ الشكل  8تاريخ ودائما طولـهmm/dd/yy  

03:logical: منطقي ويستخدم مع النوعيـة التي تتطلب اختيار من اثنين فقط

 نعم أو لا

5:memo: ملاحظات وهي تمكنك من إدخال بيانات كبيرة الحجم لاتسم حبها

  .النوعيات الاخرى

  .هنالك نوعيات أخرى ومن المفترض أنك على علم بالمتغيراتو

بدون  Useلكي يتم إغلاق ملف البيانات ندخل الامر :إغلاق  ملف البيانات �

 .أي معطيات

يليـه  Useلكي يتم فتح ملف البيانات نستخدم الامر :فتح ملف البيانات �

الذي قمنا بإنشائــه يكون الأمر كا  table1اسم الملف ولفتح الملف

 Use table1التالي

لكي يتم اضافة بيانات الى ملف البيانات المفتوح هنالك :إضافـة البيانات �

 : طريقتين

دخال ويستخدم ذالك إوسوف يظهر شاشـة  append استخدم الأمر:01

  اثناء التجارب والعمل مع قاعدة البيانات
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وسوف يظهر شاشـة ادخال وستخدم  append blankاستخدام الأمر:02

ذالك أثناء سجل فارغ ولن يظهر شاشـة لادخال البيانات حيث يتم ادخال البيانات 

  .من خلال أوامر البرمجة الخاصـة باللغة

 append الامر خلال من البيانات ادخالوالصورة التالية عبارة عن مثال عن 
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  :البيانات عرض

 browseأو الأمر  List الامر استخدام يمكن البيانات عرض يتم لكى

  List الامر خلال من البيانات ادخالوالصورة التالية عبارة عن مثال عن 

 

 الامر خلال من البيانات ادخالوالصورة التالية عبارة عن مثال عن 

browse  
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 : البيانات تعديل

 edit الامر استخدام يمكن البيانات تعديل يتم لكى  

  edit الامر خلال من البيانات ادخالوالصورة التالية عبارة عن مثال عن 
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 : البيانات حذف

 Delete  الامر باستخدام الحذف لغرض تعليمه اولا يتم سجل حذف يتم لكى

 مفاهيم وهناك Pack الامر باستخدام الحذف  لغرض المعلمة السجلات حذف ثم

 السجل لحذف انه معرفة ينبغى ولكن بعد فيما لها نتعرض سوف ذلك خلف تقف

 الامر نستخدم السجلات جميع ولحذف Delete الامر نستخدم الحالى

Delete All ائيا السجلات ولحذف الامر نستخدم Pack ولاسترجاع 

 جميع ولاسترجاع Recall الامر نستخدم الحذف لغرض المعلم الحالى السجل

 المعلم السجل    Recall all الامر نستخدم الحذف لغرض المعلمة السجلات

 الامر خلال من استعراضه عند سوداء علامة امامه تظهر الحذف لغرض

Browse الامر استخدم للفهم delete all  ثمbrowse  ثمrecall 

all  ثم.browse  

 ااك الحذف لغرض المعلمة السجلات لمعاملة set delete on الامر يستخدم

 set الامر نستخدم ذلك عن نتراجع ولكى رؤيتها يتم ولا ائيا محذوفة

delete off  

 Delete الامر خلال من البيانات ادخالوالصورة التالية عبارة عن مثال عن 

All  ثم.browse  
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  : ملحوظة

 بديل يكون والذى  ZAP الامر استخدام يمكن مباشرة السجلات جميع لحذف

  Packثم  Delete All للامرين

  

 

 

 

 

 

 

 

 

  



 E-mail :mebarkimouaadh@Gmail.com Page 

89 

Microsoft Visual FoxPro 9.0 كتاب تعلم    

Tel :+(213)792306382 رآ�                                                    :إ��اد����ذ   

  :السجلات وعدد السجل رقم معرفة

 مباشرة معاه التعامل ويمكن المؤشر عنده يقف والذى الحالى السجل رقم نعرف لكى

 او الدالة نستخدم السجلات عدد نعرف ولكى()RECNO الدالة نستخدم

  ()RECCOUNT الوظيفة

  السجلات وعدد السجل رقم معرفةعلى  والصورة التالية عبارة عن مثال
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   :السجلات بين التنقل

يذهب  Goto 5 مثل معين سجل لرقم للذهاب يستخدم GOTOالأمر  

 إلى السجل الخامس 

 .بذهب إلى السجل الأول   Goto Topالأمر  

 .يذهب إلى اخر سجل GOTO BOTTOMالأمر  

 السجل الى skip 1 فمثلا السجلات من محدد عدد يقفز SKIPالأمر  

 التالى

 .السابق السجل الى المؤشر ينقل skip-1الأمر  
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  :تعديل والحذف والإضافــة و إعداد ترتيب الحقول

من أجل تعديل والحذف والإضافــة وإعداد ترتيب الحقول ما علينا سوى إختيار 

كما هو موضح في  Table Designerثم Viewمن شريط القوائم  

  :الصورة التاليــة

  

  التعديل ولقد مرت بنا سابقا أثناء إنشاء الجدولسوف تظهر لنا نافذة 

  

 .لتعديل اسم تم تحديده ما عليك سوى النقر ثم كتابـة اسم جديد •

لحذف حقل تم تحديده ما علينا سوى الضغط على يسار الإسم فيظهر لنا  •

 Deleteثم نقوم بالنقر على nemeسهمين كما بالحقل 
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لإضافــة حقل نحدد الحقل الذي سوف يليه ثم نقوم بالنقر على الزر  •

inset  

 :كما هو موضح في الصورة التاليــة

  

 modifyبكتابــة الأمر  أو يمكننا التعديد من خلال نافذة الأمر

structure  
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  :ملاحظــة

ما علينا سوى الذهاب إلى   commandcommandcommandcommand windowمن أجل الحصول على نافذة 

window  من شريط القوائم ثم إختيارCommand window   

  

  من خلال لوحة المفاتيحCtrl+F2 أو بالقر على الزر
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  :SQL وجمل والاستعلامDatabase البيانات قاعدة

  :Remote Dataالبعيدة البيانات مع التعامل

-Client) خادم-الزبون برمجة الان البيانات قواعد برمجة مفاهيم اهم من

Server) البيانات قاعدة مع وخاصة SQLServerبالانتشار تتسم والتى 

  .العالية والسرعة الهائلة والقوة الكبير

 للبرنامج واجهةInterface بعمل تقوم ان برو سكفو فيجوال برمجة لغة وتتيح

 SQL مع التعامل خلال من البيانات بتخزين تقوم والتى اللغة خلال من

Server.  

 SQL استخدام بطريقة الجيد الالمام ينبغة الطريقة بتلك البرمجة فى للعمل وبالطبع

Server الاستعلام لغة فهم ذلككو SQL بسيط مثال هو التالى والمثال 

 اوامر خلال منSQL Server البيانات بقاعدة الاتصال يفيةك كيوضح

 SQL path : معODBC تقنية باستخدام برو سكفو فيجوال

through  
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  :نشاء قاعدة بياناتإكيفيـة 

 Microsoft Visual FoxPro 9.0 ثم نختار •

  :كما هو مبين في الصورة التاليــــــــة

 

 Foxpro 9.0فتظهر لنا الشاشــة الأساسية الخاصة ب  

  File نختار 

 New fileثم نختار  Databaseثم نختار 
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ثم نقوم بعملية حفظ التطبيع في مجلد ما ومن الأحسن أن يكون الد على سطح 

  المكتب 
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  اسم قاعدة البيانات
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  نافذة أدوات تصميم قواعد البيانات

  

  اتصالات:01

  تعديد الإجراءات المخزنــة:02

  استعراض جدول:03

  تعديد جدول:00

  تحرير العلاقات داخل قاعدة البيانات:05

  تحرير العلاقات والاتصالات داخل قاعدة البيانات اخرى:06

  حذف جدول:07

  إضافـة جدول:08

  .إنشاء جدول جديد:09
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  يمكننا الان إنشاء  جدول جديد بنفس الطريقة التي استعملناها في الدرس السابق

.إنشاء جدول جديد في البدايـة نقوم بالنقر على الزر New Table

  

في الدروس السابقة كيفية إنشاء جدول ، ونحن لن نقوم بالشرح  ولقد قمنا بالشرح

 .من أجل عدم التكرار 
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  :الكائنات برمجة 

 واغرب – هيما جيدا فهمت اذا البرمجة متعة هى الكائنات برمجة ان الواقع فى

  .واهميتها فائدا .مدى تدرك تكن لم اذا مفاهيمها

 بالمئة مئة بنسبة الكائنات برمجة تدعم التى النادرة اللغات من برو سكفو فيجوال ان

 والجداول الاحداث ادارة و الهيكلية البرمجة مثل اخرى، انماط توفر الوقت نفس وفى

  .والقالب الموجهة العلاقية
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  :النماذج ملفات

النموذج في قاعدة البيانات هو شكل لطريقــة إدخال البيانات و استخلاص النتائج 

طريق الواجهــة التي يصممها المبرمج تمكن المستخدم العادي من التعامل مع  عن

  .قاعدة البيانات بشكل  أسرع

  :وطرق الإنشاء وهي كاالتالي

 file newثم Formمن مدير المشروع أختر نموذج  �

 

ثم نقوم بعمليــة الحفظ في مجلد ما في الحاسوب ويفضل أن يكون على سطح 

  الوصول إليه بسرعــةالمكتب من اجل 
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 E-mail :mebarkimouaadh@Gmail.com Page 

103 

Microsoft Visual FoxPro 9.0 كتاب تعلم    

Tel :+(213)792306382 رآ�                                                    :إ��اد����ذ   

  :الادوات شريط

  :إلى النموذج) جديدة كائنات( عناصر اضافة فى يستخدم

  

  
Select Objects  اختيار وتحجيم أدوات التحكم  

  
View Classes  اختيار الفصائل وعرضها  

  
Label  أداة لإظهار النص  

  
Text box   أداة لإدخال معلومات بواسطـة

  المستخدم عبارة عن سطر واحد

  
Edit box  مثل السابق لكن يتيح عدة أسطر  

  
Command button   زر أمر يرتبط بحدث عند التعامل

  معه

  
Command button 

group   مجموعة من أزرار الأوامر التي تعمل

  مع بعضها

  
Option group   أزرار الاختيار إذا تم اختيار أحدهم

  لا يمكن اختيار الأخر
  

 

Check box   اختبار حالــة لتحديد خطأ أم

  صحيحـة
  

 

Combo box   قائمـة اختيارات مع إتاحـة

لإضافـة للقائمـة بواسطة 

  المستخدم
  

 

List box  قائمــة اختيارات  
  

  

Spinner  قبل قيم رقميـة في مدى تعداد ي

  من قبل المستخدم محدد
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Grid   لإظهار بيانات عناصر قاعدة

  البيانات في النموذج
  

  

Image  لإظهار صورة بالنموذج  
  

  

Timer   أداة لتوقيت أداء العمليات والأوامر

  في أوقات محددة
  

  

Page frame   عدة صفحات بالنموذج لكل صفحة

  أدوات تحكم خاصــة ا
  

  

ActiveX Control  
(OleControl)   مرتبطـة لإضافـة عناصر تحكم

  ببرنامج أخرى
  

  

ActiveX bound control  
(OleBoundControl)   مثل السابق لكنها مرتبطـة بحقل

  عام في جدول

  
Line  رسم خط  

  

  

container   إنشاء عنصر يمكنــه احتواء

  عناصر أخرى
  

  

separator   موعةعمل فواصل مسافات بين ا

  في شريط الأدوات
  

  

Hyperlink  إدراج ارتباط تشعبي  
  

  

Builder Lock   فتح أو إغلاق معالج أداة التحكم

  المختارة
  

  

Button Lock   لإضافـة نفس أداة التحكم أكثر

  واحدة من مرة بعد إختيار ها مرة

  
Shape  رسم شكل  
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  :الالوان شريط

  ).الخلفية لون – الكتابة لون(بسرعة الكائن تلوين فى يستخدم
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  :الخصائص نافذة

 الخصائص اغلب – يشملها التى والعناصر النموذج خصائص ضبط فى تستخدم

  .بسهولة معها التعامل، ويمكن مباشرة المعنى مفهومة
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  :النموذج نافذة

 العناصر افةإض يمكنك بحيث بتصميمه تقوم الذى للنموذج مباشرة حية صورة تعطى

 نافذة خلال من خصائصها فى والتحكم، الادوات شريط خلال من اللازمة

  .الاحداث نافذة خلال من بالعناصر الخاصة وادكالا تكتب ذلك بعد ثم الخصائص
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  :الاحداث نافذة

 العناصر احد او النموذج على متتايعتين مرتين الايسر الفارة بزر الضغط بمجرد تظهر

 يحتويها التى
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Form Control Toolbar Buttons :  

Edit Box  Text Box  Label  
Option Group  Command 

Group  
Command 

Button  
List Box  Combo Box  Check Box  
Image  Grid  Spinner  

OLE Container 
Control  

Page Frame  Timer  

Shape  Line  OLE Bound 
Control  

  Separator 
 Form Control Toolbar( تحكم أدوات شريط أزرار تشكيل

Buttons( : شريط ثلتم والتي ، الأدوات شريطفي   النموذج تحكم عناصرهي 

 الأزرار من اثنين رأس على.  أقسام عدة، من تكونت والتيالتحكم، لوحة الأدوات

 شريط لبقية إعدادات في للتحكم أدوات هي ذلك من بدلا ولكن ، ضوابط ليست

  .الأدوات
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   :النموذج الى عنصر اضافةكيفيــة 

 ونضغط النموذج الى الذهاب ثم الادوات شريط من العنصر نوع باختيار ذلك يتم

 ، يدنا نرفع ثم العنصر مساحة نحدد حتى، الضغط فى ونستمر الايسر الفارة بزر

 خواصه تعديل يمكن بحيث ايضا تحديده وتم النموذج على ظهر قد العنصر ان فنجد

  .الخصائص نافذة خلال من مباشرة

  

ثم ) زر أمر يرتبط بحدث عند التعامل معه( Command buttonنقوم بإضافــة زر  

  كما هو موضح في الصورة م بتغيير إسم الزر إلى خروج نقو

والنص هو ) أي أداة لإظهار نص ( Labelثم نقوم بإضــافــة خاصــة 

  "مرحبا بكم في لغة البرمجة الفكس برو:"التاليكا
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  "نافذة الخصائص"نقوم بتغيير حجم الخط من خلال 
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  :العنصر الى التعليمات اضافة

   العنصر على مرتين بالضغط عليها نحصل والتى الاحداث نافذة خلال من ذلك بتم

  

thisform.release 
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  :النموذج واختبار تشغيل

 النموذج حفظ تطلب شاشة تظهر وقد Ctrl+E على الضغط خلال من ذلك يتم

 قائمة خلال من النموذج تشغيل يمكن او – قبل من ذلك تم قد يكن لم اذا ملف فى

form ثم Runالادوات شريط خلال من او  
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  :الامر زر خصائص اهم

  Caption  )حرفى حقل( الامر زر يحمله الذى العنوان

  Forecolor  )رقمى حقل(الكتابة لون

  Fontname  )حرفى حقل(الخط اسم

  Fontsize  )رقمى حقل(الخط حجم

  Autosize  )منطقى حقل(التلقائى التحجيم

  Visible  )منطقى الحقل نوع(النموذج على الظهور

  Enabled  )منطقى حقل(التمكين

  Top  )رقمى حقل(النموذج فى العنصر لبداية الصف رقم

 Left  )رقمى حقل(النموذج فى العنصر لبداية العمود رقم

 Width  )رقمى حقل(العنصر عرض

 Height  )رقمى حقل(العنصر طول

 Name  العنصر اسم

 ToolTipText  السريعة المعلومة رسالة

 الخصائص نافذة خلال من ضبطها ويمكن العناصر بين شائعة الخصائص هذه ومعظم

 التالىك العناصر او بالنموذج الخاصة الاحداث، داخل التعليمات خلال من او
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  :نصال مربع خصائص اهم

  Value  النص مربع يحتويها التى القيمة

  Forecolor  )حقل رقمي( الكتابة لون

  Fontname  )حقل حرفي( الخط اسم

  Fontsize  )رقمى حقل(الخط حجم

  Autosize  )منطقى حقل( التلقائى التحجيم

  Visible  )منطقى الحقل نوع( النموذج على الظهور

  Enabled  )حقل منطقي( التمكين

  Top  )حقل رقمي( النموذج فى العنصر لبداية الصف رقم

  Left  )حقل رقمي(النموذج فى العنصر لبداية العمود رقم

  Width  )حقل رقمي( العنصر عرض

  Height  )حقل رقمي( العنصر طول

  Name  العنصر اسم

  backcolor  الخلفية لون

  RightToLeft  )حقل منطقي( لليسار اليمين من تابةك

  Alignment  )رقمى حقل(المحاذاة

  MaxLength  للادخال طول اقصى

 InputMask  الادخال شروط

 ToolTipText  )حرفي( السريعة المعلومة رسالة

 التعامل يفيةك معرفة) التجربة ، باللغة الخاصة المساعدة شاشات(خلال  من ويمكنك

  قد التى العناصر جميع مع

 بعض الى تحتاج فقط وانما ذلك فى صعوبة تجد لن انك دأكوت النموذج عليها يشتمل

 .الوقت
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  Visual FoxPro 9.0كيفيـة إنشاء ألة حاسبـة بلغة البرمجة 

التي   Windowsأو إبدأ حسب    Démarrerاو  Starنقوم بالنقر على 

  :تستعملها أنا أستعمل النسخة الفرنسيــة ونتبع الخطوات التاليــة

 Démarrerنقوم بالنقر على زر •

 Tous les Programmesنقختار  •

 Microsoft Visual FoxPro 9.0 ثم نختار •

  :كما هو مبين في الصورة التاليــــــــة

 

 Foxpro 9.0فتظهر لنا الشاشــة الأساسية الخاصة ب  
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 ..Newثم نحدد   Fileثم نختار 

، كما هو موضح في الصورة New fileثم نقوم بالنقر على Formثم نختار 

   :التاليـة
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  :في هذا التطبيق نحن بحاجــة إلـى

 أزرار: 5 •

• 3TextBox : 

 خلالو من  textBoxيمكننا الحصول على الأزرار  

Toolber Form Controle   

  

 Color Palette Toolberويمكننا تغيير لون الخلفيــة من خلال 
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كتغيير  Formيمكننا التحكم في  Properties Windowمن خلال 

إسم النافذة وكذالك اللون وحجم النافذة  وكذالك التحكم في جميع خصائص 

Form Controle  الخ....كتغيير اسم الزر حجم الزر  

  من خلال الزر  Properties Windowيمكننا الحصول على 
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  :بعد التغيير نتحصل على البرنامج كما هو موضح في الصورة التالية

  

  Propertiesمن خلال  TextBox 2الأن سوف نقوم بالتعديل على 

 Window  
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  0القيمــة  Valueنقوم بإعطاء 

نقوم بنفس الخطوات السابقة كما هو موضح في Textbox3بالنسبة إلى الخاصية 

  0القيمة Valueالصورة أي إعطاء 
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 Sumar ننتقل الأن إلى كتابـة الكود،نقوم الأن بكتابة الكود الخاص بالزر

نقوم من  Commandمرتين نتحصل على النافذة  Sumarبالنقر على الزر 

  هو موضح في الصورة خلالها بكتابة الكود كما

  

 Command1الكود الخاص ب

  :هو كاالتالي
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Value .text2.thisform= Value.text1.thisform

value.text3.thisform+    

  Command 2ثم ننقل إلى كتابة الكود الخاص

  

  :هو كاالتالي Command2الكود الخاص بالزر 

thisform.text1.Value= thisform.text2.Value 

- thisform.text3.value  

   Command 3ننقل إلى كتابة الكود الخاص

  

  :هو كاالتالي Command 3الكود الخاص بالزر

thisform.text1.Value= thisform.text2.Value 

  thisform.text3.value *  

  Command 4ننقل إلى كتابة الكود الخاص
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  :والكود هو كاالتالي

thisform.text1.Value= thisform.text2.Value 

/ thisform.text3.value  

  Command 5ننقل إلى كتابة الكود الخاص

  

thisform.Release  

  ببرنامج من خلال الزر   Runثم نقوم بعمليــة 

 Do You want to save changes to form سوف نلاحظ

Desinger-FormDoc1 ? 

   

مجلد على سطح المكتب قد قمنا بإنشائه ونقوم بحفظ الملف في Yesنحن نقوم بالضغط على الزر 

  .من قبل
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 Enregisterثم نضغط على 

  

  .نلاحظ أن البرنامج يعمل دون أي أخطاء
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  .مفكرة هاتف بسيطة بلغة البرمجة الفكس برو

التي   Windowsأو إبدأ حسب    Démarrerاو  Starنقوم بالنقر على 

  :تستعملها أنا أستعمل النسخة الفرنسيــة ونتبع الخطوات التاليــة

 Démarrerنقوم بالنقر على زر •

 Tous les Programmesنقختار  •

 Microsoft Visual FoxPro 9.0 ثم نختار •

  :كما هو مبين في الصورة التاليــــــــة

 

 Foxpro 9.0فتظهر لنا الشاشــة الأساسية الخاصة ب  
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 ..Newثم نحدد   Fileثم نختار 

، كما هو موضح في الصورة New fileثم نقوم بالنقر على Formثم نختار 

   :التاليـة
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  :في هذا التطبيق نحن بحاجــة إلى

 Commandثلاثــة أزار  •

 Addالزر الاول 

 Deleteالزر الثاني 

 Closeالزر الثالث 

 Text Boxخاصيــة  •

 Labelخاصيــة   •

 List Boxخاصيــة  •

 

  ننتقل الأن إلى كتابــة الكود
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 Addالكود الخاص بزر 

If .not. empty(alltrim(ThisForm.Text1.value)) 
THISFORM.LockScreen = .T. 
nCnt = 1 
DO WHILE nCnt <= THISform.list1.ListCount 
IF upper(alltrim(THISform.list1.listitem(nCnt))) ==; 
upper(alltrim(ThisForm.Text1.value)) 
mymsg = messagebox("The statement is already 
added",6,"Sorry") 
return 
ELSE 
nCnt = nCnt + 1 
ENDIF 
ENDDO 
THISFORM.LockScreen = .F. 
ThisForm.List1.additem(alltrim(ThisForm.Text1.val
ue)) 
Else 
mymsg = messagebox("enter the statement 
",6,"sorry") 
Endif 
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  Deleteالكود الخاص بزر 

THISFORM.LockScreen = .T. 
nCnt = 1 
DO WHILE nCnt <= THISform.list1.ListCount 
IF THISform.list1.Selected(nCnt) 
THISform.list1.RemoveItem(nCnt) 
ELSE 
nCnt = nCnt + 1 
ENDIF 
ENDDO 
THISFORM.LockScreen = .F.  
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  Closeالكود الخاص بزر 

thisform.Release 

 

  ببرنامج من خلال الزر   Runثم نقوم بعمليــة 

 Do You want to save changes to form سوف نلاحظ

Desinger-FormDoc1 ? 

   

ونقوم بحفظ الملف في مجلد على سطح المكتب قد قمنا بإنشائه Yesنحن نقوم بالضغط على الزر 

  .من قبل
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 Enregisterثم نضغط على 
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 PENGENALAN CONTROL IMAGE PADAبرنامج 

VISUAL FOXPRO  

التي   Windowsأو إبدأ حسب    Démarrerاو  Starنقوم بالنقر على 

  :تستعملها أنا أستعمل النسخة الفرنسيــة ونتبع الخطوات التاليــة

 Démarrerنقوم بالنقر على زر •

 Tous les Programmesنقختار  •

 Microsoft Visual FoxPro 9.0 ثم نختار •

  :كما هو مبين في الصورة التاليــــــــة

 

 Foxpro 9.0فتظهر لنا الشاشــة الأساسية الخاصة ب  
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 ..Newثم نحدد   Fileثم نختار 

، كما هو موضح في الصورة New fileثم نقوم بالنقر على Formثم نختار 

   :التاليـة
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  :في هذا التطبيق نحن بحاجــة إلى

• Image 

 Check boxثلاث خصائص  •

 Command زر •

  

  ننتقل الأن إلى كتابــة الكود 

  :ونقوم بكتابــة الكود التاليClip نقوم بالنقر على الخاصيــة

thisform.image1.Stretch= 0 
thisform.image1.Picture= 'mouaadhmebarki.JPG'  
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  :ونقوم بكتابــة الكود التالي  Isometicثم نقوم بالنقر على 

thisform.image1.Stretch= 1 
thisform.image1.Picture= 'mouaadhmebarki.JPG'  

  

  :ونقوم بكتابــة الكود التالي stretchثم نقوم بالنقر على 

thisform.image1.Stretch= 2 
thisform.image1.Picture= 'mouaadhmebarki.JPG'  

  

 closeثم نقوم بكتابــة الكود الخاص بالزر 

thisform.Release 
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  ببرنامج من خلال الزر   Runثم نقوم بعمليــة 

 Do You want to save changes to form سوف نلاحظ

Desinger-FormDoc1 ? 

   

ونقوم بحفظ الملف في مجلد على سطح المكتب قد قمنا بإنشائه Yesنحن نقوم بالضغط على الزر 

  .من قبل
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 Enregisterثم نضغط على 
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  التقارير في الفكس بروبناء 

التقرير هو وسيلــة لعرض  البيانات المختارة من جدول أو أكثر بالترتيب والمعيار 

  الذي نحدده وسنقوم بعمل تقرير بسيط بإستخدام المعالج

التي   Windowsأو إبدأ حسب    Démarrerاو  Starنقوم بالنقر على 

  :تستعملها أنا أستعمل النسخة الفرنسيــة ونتبع الخطوات التاليــة

 Démarrerنقوم بالنقر على زر •

 Tous les Programmesنقختار  •

 Microsoft Visual FoxPro 9.0 ثم نختار •

  :كما هو مبين في الصورة التاليــــــــة

 

 Foxpro 9.0فتظهر لنا الشاشــة الأساسية الخاصة ب  
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 ..Newثم نحدد   Fileتار ثم نخ

 New fileثم نختار  Reportثم نقوم بإختيار 

  :كما هو موضح في الصورة التاليــة
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 Allثم تختار Wizards ثم نختار  Toolsمن قائمــة الأدوات نختار 

Wizards 

  

نقوم بتحديد  Wizard Selectionسوف نتحصل على النافذة 

Report Wizard كما هو موضح في الصورة التاليــة  

  

  :بعد الضغط على موافق سنبدأ بالتعامل مع معالج التقرير في عدة خطوات
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 اختيار الحقول حيث يتم تحديد حقول الجدول المراد ظهورها في التقرير 

 تجميع السجلات في مجموعات وهي عمليـة اختياريــة 

 تحديد نسق أو منظر التقرير 

 ر هل بالحقل أم بالسجلنظام العرض للتقري 

 ترتيب السجلات 

 النهايـة حيث يتاح لنا استعراض التقرير قبل حفظــه 

  سنتعامل مع الجدول الذي إستخدمناه في الدروس السابقــة: اختيار الحقول:1

  

  بالضغط على استعراض الملفات 

  نقوم بتحديد الملفات لإختيار مسار الجدول
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 Nextنقوم بالتعديل كما هو مبين في الصورة ثم نقوم بالنقر على 
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في هذه الخطوة إذا رغبت يمكنك التجميع بواســطة : تجميع السجلات:02

فكل ماعلينا هو  مجموعات ولنفرض أننا نرغب في التقرير يعرض مجموعات الوظائف

  تحديد حقل الوظيفيــة كما بالصورة

  

  Next نقوم بالضغط على التالي

اختر التصميم الذي ترغب به ويمكنك المعاينــة له :تحديد نسق ومظهر التقرير:03

إا عمليـة ذوق يمكنك ان تختار  LEDGERتحت العدسـة انا افضل دفتر الأستاذ 

  ما يحلو لك 
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  Next لتالياثم نقوم بالضغط على 

الرأسية او الصفحـة نجد لدينا الاختيار ما بين الصفحـة : نظام العرض بالتقرير:04

الأفقيـة كنظام لعرض التقرير كذالك بعض الوظائف الغير متاحـة وذالك نتيجـة 

  لاستخدامنا اموعـة في الخطوة الثانيـة
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  :نلاحظ أن الوظائف المعطلـة هي 

  .حقول للعرض بالتقرير 3إلـى  1عدد الحقول وهي تسمح بالتقسيم إلى حقول من 

توضح عناوين الحقول مرة واحدة :"صورة التقرير كما يليالعرض بالحقول ويكون 

  ".أعلي التقرير وتحت منها قيم السجلات

  العرض بالسجلات ويتم عرض سجل سجل ويتم عرض الحقول وقيمها لكل سجل 

  Next ثم نقوم بالضغط على التالي

وهي خطوة اختياريـة وليست اجباريـة وفيها نختار الحقول : ترتيب السجلات:5

  . نرغب في عرض التقرير بناء على ترتيبها التصاعدي أو التنازليالتي
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نصل إلى المحطـة الأخيرة والمهمة لتدريبنا في نفس الوقت  Nextبالضغط على 

  وسنتوقف لديها طويلا 

   :النهايــة:06

  



 E-mail :mebarkimouaadh@Gmail.com Page 

150 

Microsoft Visual FoxPro 9.0 كتاب تعلم    

Tel :+(213)792306382 رآ�                                                    :إ��اد����ذ   

  Finishنقوم بالنقر على الزر 

  

  ونقوم بحفظ كما هو موضح في الصورة السابقــة

  ونكون قد وصلنا إلى ايــة هذا الدرس 
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   The Application Wizardمعالج التطبيق

في هذا الدرس ننتقل إلى مستوى متوسط حيث نتحرك إلى ما يسمى بالتطبيق المتكامل 

ومعالج التطبيق هو الخطوة الاولى إذ يقوم بتجميع جميع الملفات اللازمـة للتطبيق 

الحقيقــة أنه ينشأ    Microsoft Visual FoxProالخاص 

  .مشروع قاعدة بيانات

ثم  Toolsننتقل الأن لتشغيل المعالج من خلال قائمـة الأدوات نختار 

Wizards   ثم نقوم بإختيارApplication  كما هو موضح في

 :الصورة التالـــة

  

المستطيل الأول وستجد في الصندوق الحواري التالي يتم كتابــة اسم المشروع في 

أن المستطيل الثاني سيتم كتابــة المسار القترح للمشروع  تلقائيا وبالطبع يمكنك 

 Browseالإستعراض  تغيير
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يراعي كتابــة اسم مختصر للمشروع كذالك انصح بإختيار المربع الخاص  �

بإنشاء هيكل مجلدات المشروع حيث يصمم مجلدات فرعيـة لتنظيم الملفات 

 .يتم إنشائها التي

بالضغط على موافق سيبدأ المعالج  في تكوين  عناصر المشروع ثم ينشأ ملف  �

بأن التطبيق مساعدة لشرح طريقـة استخدام معالج التطبيق 

Application Builfer لتطوير تطبيقك. 

  

 General:التبويب العام
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 Name: لوضع اسم لتتطبيق يستخدم في شريط العنوان وملف عن

About وخلال تطبيقك. 

 Image : مسار ملف الصورة التي تستخدم كمقدمـة وفي ملف عن

About 

 Common Dialogs : مربعات الإختيار تسمح لك بإدراج بعض أو

 .كل الوضائف التاليــة في تطبيقك

 Splash Screen:يحدد إذا ما كان التطبيق سيبدأ بملف الصورة 

 Quick Start Form  يسمح بالتشغيل السريع للمستخدم

 .لنموذج او تقرير بإستخدام قائمـة سريعـة

 About dialog :ظهور ملف عن ضمن التطبيق لتحديد 

 User Logins:يتم إنشاء "المطالبــة بإسم وكلمة سر المستخدم

وكلمــة UserIPتلقائيا وبه تعريف المستخدم  AppUserجدول 

 "PassWordمرور

  :Application Type نوع التطبيق 

 Normal:العادي" وهو الوضع الإفتراضي للتطبيق" 

 Module:تطبيق يتم استدعائه من تطبيق آخر 

 Top_Level:تطبيق يعمل بنافذة منبثقة من الفكس برو 

 Icon:مسار ملف أيقونـة البرنامج 
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  : Creditsالتبويب 

ويسمح لك هذا التبويب بإدخال معلومات عن كريق التطبيق تظهر في المقدمـة 

 .الحواري About وصندوق 

 

  .معالج إنشاء جدول جديد 

  معالج إنشاء قاعدة بيانات 
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Datasource:إسم الجدول  

Form:هل ترغب بعمل نموذج  

Report:هل ترغب بعمل تصميم  

  زر إنشاء النماذج والتقرير

  التقريرتنسيق 

  تنسيق النموذج

اختيار قاعدة "لإختيار جدول أو قاعدة بيانات موجودة بالفعل لإستخدام

  "بيانات يضيف جميع جداولها

  .لحذف الجدول الذي لا ترغب في إضافتــه للتطبيق 

بعد اختيار للجدول و وضع علامات الرغبــة في عمل نموذج وتقرير 

وتنسيق التقرير من  Style Formبعد اختيار للتنسيق الخاص بالنموذج من 

Report Style  يمكنك أن تضغط زرGrnerte  لتجعل المعالج ينشئ

  .النموذج والتقرير تلقائيا
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تحها في تحديد إمكانيــة عدد نسخ النموذج التي يمكن ف 

  .نفس الوقت لنموذج واحد 

  .استخدام أدوات التنقل بين السجلات 

  استخدام قائمــة للتنقل بين السجلات 

  .إظهار اسم النموذج في صندوق الحواري لتطبيق جديد 

  إظهار اسم النموذج في صندوق الحواري لفتح تطبيق 

 .لإضافــة نموذج 

  .مصمم النماذجلتعديل في النموذج المحدد بإستخدام 

  .حذف النموذج المحدد

  :Reportsالتبويب 
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  :Advancedالتبويب

  

تحديد مسار  

  .ملف المساعدة للتطبيق

تحديد مسار  

  الد الإفتراضي للمشروع
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القوائم لإتاحــة أو عدم إتاحـة القوائم  

  :وهي تتكون من .التاليــة

  ظهور شريط الأدوات القياسي 

  ظهور قائمــة المفضلــة 

للرجوع عن أي تغيير تم إحداثــه بالعنصر النشط كمسح  

  السجلات الموجودة بالجداول او مسح الجدول نفســه

فنتحصل على نافذة المشروع بعض الإنتهاء نقوم بالنقر على الزر

Project Manager  والخاصــة بتنضيم مشروعــك وتطبيق

  .والتعديل عليــه

  

 ..Bulidولكن نحن كل ما يهمنا هو الزر 
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وهو زر بناء التطبيق وهو خاص بعمل الملف التشغيلي للمشروع فبالضغط عليه 

  :نجد النافذة التاليــة

  

  اشاء وبناء ملف المشروع

بناء المشروع وترجمــه في ملف قابل للتشغيل له 

 appالإمتداد

 Exe/COMلعمل ملف تنفيذي  
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Object Properties, Events, and Methods ActiveDoc:  

 تم التي و والأساليب، ، الأحداث خصائص على تويتح ActiveDoc فئةإن  

  :التاليــة الجداول في تعريفها

ActiveDoc Class Properties:  

الوصف أو 

  التعريف

Description  Property  

 على يحتوي

 اسم

FoxPro 
 الفئة أي مرئي

 الأساسية

 يستند تيال

 المشار الكائن

  .إليه

Contains the 
name of the 
Visual 
FoxPro base 
class 
on which the 
referenced 
object is 
based.  

BaseClass  

 النص يحدد

 في المعروض

  .الكائن شرح

Specifies the 
text 
displayed in 
an object's 
caption.  

Caption  

 على يحتوي

 التي الفئة اسم

 كائن

  .على مبني

Contains the 
name of the 
class on 
which an 
object 
is based.  

Class  

 على يحتوي

 من الملف اسم

Contains the 
filename of 
the user-

ClassLibrary  
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 من المعرفة فئة

 المستخدم قبل

 التي المكتبة

 فئة على تحتوي

  .الكائن

defined class 
library that 
contains the 
object's 
class.  

 المعلومات يخزن

  .كائن حول

Stores 
information 
about an 
object.  

Comment  

 إذا ما يحدد

 المستند كان

 تبقى النشط

 قيد و مفتوحة

 عند التشغيل

 من إصدارها

 لها المضيف قبل

.  

Specifies 
whether an 
Active 
document 
remains 
open and 
running 
when it is 
released by 
its host.  

ContainerReleaseType  

 اسم حدد

 ل المستخدم

 في كائن مرجع

 التعليمات

  .البرمجية

Specifies the 
name used to 
reference an 
object in 
code.  

Name  

 كائن مراجع

 عنصر حاوية

  . تحكم

References 
the container 
object of a 
control.  

Parent 

 Specifies the ParentClass  الفئة اسم يحدد
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 فئة ويستند

  .الكائن

name of the 
class on 
which the 
object's class 
is based.  

 أي بتخزين

 إضافية بيانات

 المطلوبة

  .للبرنامج

Stores any 
extra data 
needed for 
your 
program.  

Tag 

  

ActiveDoc Class Events:  

الوصف او 

  التعريف

Description  Event )الحدث( 

 هذا تشغيل يتم

 مستند عند الحدث

 نشط

 المضيف بإعلام

 التي النشطة وثيقة

 أمر

 سيتم التي و

  .تنفيذها

This event is 
triggered 
when an 
Active 
document 
host notifies 
an Active 
document 
that a 
command 
is to be 
executed.  

CommandTargetExec  

 وثيقة تحديث عند

 النشط المضيف

 مستخدميها

 يتم و واجهة،

When an 
Active 
document 
host updates 
its user 

CommandTargetQuery  
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 interface, this   الحدث هذا تشغيل
event is 
triggered.  

 إصدار عند

 وثيقة مجموعة

 ، هذه النشطة

  الحدث تشغيل يتم

When a host 
releases an 
Active 
document, 
this 
event is 
triggered.  

ContainerRelease  

 تحرير يتم عندما

 هذا النشط المستند

 الحدث

  . تشغيل يتم

When the 
Active 
document is 
released, this 
event 
is triggered.  

Destroy  

 وقت خطأ عندما

 وثيقة في التشغيل

 النشيطة

 ، الأسلوب يحدث

 هذا تشغيل يتم

  . الحدث

When a 
runtime error 
in an Active 
document's 
method 
occurs, this 
event is 
triggered.  

Error  

 يتنقل عندما

 نشط من المستخدم

 تشغيل يتم ، وثيقة

  . الحدث هذا

When the 
user 
navigates 
from an 
Active 
document, 
this event is 
triggered.  

HideDoc  

  This event is Init هذا تشغيل يتم
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 عندما الحدث

 المستند يكون

 النشطة

  .إنشاؤه تم

triggered 
when the 
Active 
document 
is created.  

 هذا تشغيل يتم

 مستند عند الحدث

 نشط

 استعداد على

 التعليمات لتشغيل

 التي البرمجية

. المستخدم يحددها

 تشغيل

 بتمرير الأمر

URL إلى 

 .تشغيل الحدث

ATED .  

This event is 
triggered 
when an 
Active 
document 
is prepared to 
run user-
defined code. 
The Run 
command 
passes a URL 
to the Run 
event. 

Run 

 هذا تشغيل يتم

 عندما الحدث

 ل المستخدم يتنقل

  . النشطة وثيقة

This event is 
triggered 
when the user 
navigates to 
an Active 
document. 

ShowDoc 
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ActiveDoc Class Methods:  

الوصف او 

  التعريف

Description  Method  

 هذا ويضيف

 خاصية الأسلوب

  .كائن

This 
method 
adds a 

property to 
an object.  

AddProperty 
(cPropertyName [, 
eNewValue])  

 الأسلوب هذا

 التعبير بإرجاع

 المستخدم الذي

 إطار في يدخل

 المحدد خصائص

  . الملكية

This 
method 
returns the 
expression 
that the 
user 
enters in 
the 
Properties 
window for 
the 
specified 

property.  

ReadExpression 
(cPropertyName)  

 الأسلوب هذا

 النص بإرجاع

 المرتبطة

  .المحدد طريقة

This 
method 
returns the 
text 
associated 
with the 

specified 
method.  

ReadMethod(cMethod)  

 الطريقة هذه

 استعادة

This 
method 
restores a 

ResetToDefault(cValue)  
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 و الممتلكات،

 طريقة أو ، الحدث

 الإعداد إلى

 لها الافتراضي

 الفوكس البصرية

 جميع.  برو

userdefined 
 إذا كود إزالة تتم

 تعيين إعادة كنت

. الحدث أو طريقة

cValue هو 

 اسم

 أو الممتلكات

 أو الحدث

  .الأسلوب

property, 
event, or 
method 
to its Visual 
FoxPro 
default 
setting. All 
of the 
userdefined 
code is 
removed if 
you are 
resetting a 
method or 
event. 
cValue is 
the name of 
the 

property, 
event, or 
method.  

 الأسلوب هذا

 محدد مثيل يوفر

 تعترض كما

 فئة في فئة تعريف

 معينة

  .المكتبة

This 
method 
saves an 
instance of 
a specified 
object as a 
class 
definition 
in the 
specified 
class 

library.  

SaveAsClass 
(ClassLibName, 
ClassName [, 
Description])  
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 الأسلوب هذا

 التعبير يكتب

 ل المحدد

  . الملكية

This 
method 
writes the 
specified 
expression 
to a 

property.  

WriteExpression 
[cPropertyName, 
cExpression]  
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Microsoft Naming Conventions:  

Example Object Object Prefix 
chkReadOnly CheckBox chk 
cboEnglish ComboBox cbo 
cmdCancel CommandButton cmd 
cmgChoices CommandGroup cmg 
cntMoverList Container cnt 
ctlFileList Control ctl 
user-defined Custom <user-defined> 
edtTextArea EditBox edt 
frmFileOpen Form frm 
frsDataEntry FormSet frs 
grdPrices Grid grd 
grcCurrentPrice Column grc 
grhTotalInventory Header grh 
imgIcon Image img 
lblHelpMessage Label lbl 
linVertical Line lin 
lstPolicyCodes ListBox lst 
olbObject1 OLEBoundControl olb 
oleObject1 OLE ole 
optFrench OptionButton opt 
opgType OptionGroup opg 
pagDataUpdate Page pag 
pgfLeft PageFrame pgf 
sepToolSection1 Separator sep 
shpCircle Shape shp 
spnValues Spinner Spn 
txtGetText TextBox txt 
tmrAlarm Timer tmr 
tbrEditReport ToolBar tbr 
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:Commands in the Window Menu with Their Shortcut Keys 

Command Shortcut Key 
Restore Ctrl+F5 
Move Ctrl+F7 
Size Ctrl+F8 
Minimize Ctrl+F9 
Maximize Ctrl+F10 
Close Ctrl+F4 
Next Window Ctrl+F6 
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:List-Source Values for List Boxes 

Source ID Source 
0 None 
1 Value 
2 Alias 
3 SQL statement 
4 Query (.QPR) 
5 Array 
6 Fields 
7 Files 
8 Structure 
9 Pop-up 
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  يمراله لكشلا ةعابط جمانرب

التي   Windowsأو إبدأ حسب    Démarrerاو  Starنقوم بالنقر على 

  :تستعملها أنا أستعمل النسخة الفرنسيــة ونتبع الخطوات التاليــة

 Démarrerنقوم بالنقر على زر •

 Tous les Programmesنقختار  •

 Microsoft Visual FoxPro 9.0 ثم نختار •

  :كما هو مبين في الصورة التاليــــــــة

 

 Foxpro 9.0فتظهر لنا الشاشــة الأساسية الخاصة ب  
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 ..Newثم نحدد   Fileثم نختار 

، كما هو موضح في الصورة New fileثم نقوم بالنقر على Formثم نختار 

   :التاليـة
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:في هذا التطبيق نحن بحاجــة إلى  

 Commandزر  •

  

  تتنقل إلــى كتابــة الكود

LOCAL n,s,x,y 
n=4 
s=1 
for x = 1 to n 
? space(n-x) 
FOR y = 1 to s 
?? "*" 
ENDFOR 
s = s + 2 
ENDFOR 
MESSAGEBOX("حSTUV دXYZا \]S^_ `",0,"`") 
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 E-mail :mebarkimouaadh@Gmail.com Page 

175 

Microsoft Visual FoxPro 9.0 كتاب تعلم    

Tel :+(213)792306382 رآ�                                                    :إ��اد����ذ   

  :حساب متوسط عددينبرنامج 

التي   Windowsأو إبدأ حسب    Démarrerاو  Starنقوم بالنقر على 

  :تستعملها أنا أستعمل النسخة الفرنسيــة ونتبع الخطوات التاليــة

 Démarrerنقوم بالنقر على زر •

 Tous les Programmesنقختار  •

 Microsoft Visual FoxPro 9.0 ثم نختار •

  :كما هو مبين في الصورة التاليــــــــة

 

 Foxpro 9.0فتظهر لنا الشاشــة الأساسية الخاصة ب  
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 ..Newثم نحدد   Fileثم نختار 

، كما هو موضح في الصورة New fileثم نقوم بالنقر على Formثم نختار 

   :التاليـة
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:في هذا التطبيق نحن بحاجــة إلى  

 Commandزر  •

• Label 

• Text Box2 

 

  :الكود هو كا التالي

LOCAL x,r 
r = 0 
n1 = VAL(thisform.text1.value) 
n2 = VAL(thisform.text2.value) 
FOR x = n1 TO n2 
r = r + x 
NEXT 
r = r / ((n2 - n1)+1) 
thisform.label1.Caption = STR(r)  
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  15إلى  1العد والتربيع والتكعيب من برنامج 

التي   Windowsأو إبدأ حسب    Démarrerاو  Starنقوم بالنقر على 

  :تستعملها أنا أستعمل النسخة الفرنسيــة ونتبع الخطوات التاليــة

 Démarrerنقوم بالنقر على زر •

 Tous les Programmesنقختار  •

 Microsoft Visual FoxPro 9.0 ثم نختار •

  :الصورة التاليــــــــةكما هو مبين في 

 

 Foxpro 9.0فتظهر لنا الشاشــة الأساسية الخاصة ب  
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 ..Newثم نحدد   Fileثم نختار 

، كما هو موضح في الصورة New fileثم نقوم بالنقر على Formثم نختار 

   :التاليـة
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:في هذا التطبيق نحن بحاجــة إلى  

 Commandزر  •

  

 

  :هو كا التالي الكود

*Programming Bymebarkimouaadh 
*Email=mebarkimouaadh@Gmail.com 
LOCAL x 
FOR x = 1 TO 15 
? STR(x) + SPACE(10) + STR(x*x) + SPACE(10) 
+ STR(x*x*x) 
NEXT  
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 الفهرس
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 العنوان رقم الصفحــة

 :Visual FoxProتاريخ  03

 Micosoft Visual FoxPro 9.0كيفيــة تثبيت  05

 Microsoft Visual FoxPro 9.0التعرف على  13

 Hello Worldالرنامج الشهير  16

  :الألوان التي يتعامل معها الأمر 19

 

 ):The Main Menu Bar( الرئيسية القوائم شريط 20

 

23 The File Menu Options:  

 

27 The Edit Menu Options:  

 

33 The View Menu Options:  

 

36 The Format Menu Options:  
 

38 The Tools Menu Options: 

01 Default Macro Definitions for 
Function Keys:  

 

02 The Program Menu Options:  
 

00 The Window Menu Options:  

 

07 Values Found in the Flag Column of 
the Grid in the Code Analyzer 

 

 ):Functions(الدوال 08

 Structure(مفهوم البرمجة الهيكليــة 09

Programming(: 
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   )Procedures(ملفات الإجراء 56

 Doالأمر  60

 

  Returnالأمر 61

 :Procedureالأمر  62

63 Function الامر 

 scope of variables : والدوال المتغيرات مجال 60

& functions 

  Control Structure: التحكم يباتكتر 66

 

  Expression : التعبيرات 68

 

  :ملفات البيانات 75

 

   )جدول( البيانات ملف انشاء 78

 

  :البيانات عرض 80

 

 : البيانات تعديل 86

 

  :السجلات وعدد السجل رقم معرفة 89

 

 السجلات بين التنقل 90

  :تعديل والحذف والإضافــة و إعداد ترتيب الحقول 91

 

 :SQL وجمل والاستعلامDatabase البيانات قاعدة 90

 :Remote Dataالبعيدة البيانات مع التعامل 90

  :كيفيـة إنشاء قاعدة بيانات 95

 

 الكائنات برمجة 100

 :النماذج ملفات 101

  :الادوات شريط 103
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  :الالوان شريط 105

 

 الخصائص نافذة 106

  :النموذج نافذة 107

 

  :الاحداث نافذة 108

 

109 Form Control Toolbar Buttons 

   النموذج الى عنصر اضافةكيفيــة  110

 

  العنصر الى التعليمات اضافة 113

 

  النموذج واختبار تشغيل 110

 

 الامر زر خصائص اهم 115

 نصال مربع خصائص اهم 116

 Visual كيفيـة إنشاء ألة حاسبـة بلغة البرمجة  119

FoxPro 9.0 
 

 .مفكرة هاتف بسيطة بلغة البرمجة الفكس برو 117

 PENGENALAN CONTROLبرنامج  130

IMAGE PADA VISUAL FOXPRO  
 

 بناء التقارير في الفكس برو 101

 The Application Wizard التطبيقمعالج  151

160 ActiveDoc Object Properties, Events, 
and Methods 

168 Microsoft Naming Conventions  
 

168 Commands in the Window Menu with 
Their Shortcut Keys 

170 List-Source Values for List Boxes 
 

طباعة الشكل الهرميبرنامج  171  

حساب متوسط عددينبرنامج  170  
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العد والتربيع والتكعيببرنامج    
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وصلنا إلى الخاتمــة، وحتى أعطي كل ذي حق حقــه وفي النهايــة نكون قد 

  بعض هذه الدروس مقتبسا من مجموعة من الكتب العربية والأجنبيــة

  

  2/07/2015بحمد االله في تم 

mebarkimouaadh@Gmail.com 

 

  


